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GETTING STARTED

Cameo Data Modeler plugin provides data-related modeling for MagicDraw. It includes entity-relationship,
database and XML schema modeling features.

This plugin enables you to draw entity-relationship diagrams (using the crow's foot notation). This is a full-
featured variant of ER diagram (including extended entity-relationship concepts - like generalization), providing
a spectrum of capabilities for logical data modeling.

This plugin provides SQL database modeling / diagramming and DDL script generation / reverse features. It
supports 11 flavors of databases (including Standard SQL, Oracle, DB2, Microsoft SQL Server, MySQL,
PostgreSQL), has separate type libraries for them, carries additional modeling extensions for Oracle
databases, Transformations from / to plain UML models and from ER models are provided.

This plugin provides XML schema modeling / diagramming and schema file (*.xsd) generation / reversing
features. Transformations from / to plain UML models are provided.

NOTES e Cameo Data Modeler plugin is a separately purchasable add-on for MagicDraw
Standard and Professional Editions and free of charge for MagicDraw Enterprise and
Architect editions.

e Cameo Data Modeler plugin replaces previous (free) Data Modeling Notations plugin
that supported the business entity-relationship diagram, a simplified version of entity-
relationship diagram, usable for high level, abstract domain data modeling.

e This plugin repackages database and XML schema modeling functionality, which
was previously available only in MagicDraw Architect and Enterprise editions.

To install Cameo Data Modeler plugin

1. From the Help menu, select Resource/Plugin Manager.
2. Select Cameo Data Modeler plugin to download and install it.
3. Restart MagicDraw to activate Cameo Data Modeler plugin.

Note that when you install the plugin, you get an evaluation key automatically. This key is good for 7 days.
Afterwards you need to purchase a license for a plugin to work on diagrams provided by the plugin (when initial
license expires, diagrams are switched to the read-only mode).

For more information on how to work with the Resource/Plugin Manager dialog, see MagicDraw User's
Manual.pdf.




ENTITY-RELATIONSHIP (ER)
MODELING AND DIAGRAMS

Cameo Data Modeler plugin brings in the following:
e Entity Relationship profile.
e Entity Relationship diagram.
e Template for new ER project creation.
e Sample, demonstrating ER modeling features.
e ER to SQL (Oracle and Generic) transformation and accompanying traceability features.

e Entity-Relationship and SQL report.

Entity-Relationship diagram, as the name suggests, allows specifying entities and relationships between them.
It is useful for the abstract domain modeling - to provide structure for data in the domain. It is much more
abstract and implementation-independent than the SQL diagram, which shows the concrete implementation of
the data structure in the database.

An entity is any thing that is capable of an existence. An entity usually refers to some aspect of the real world,
which can be distinguished from other aspects of the real world (a person, place, customer transaction,
order...).

An entity is represented by a box shape on the diagram. An entity has two compartments where properties
(columns) of the entity can be specified. The upper compartment holds primary key properties of the entity;
lower - other properties.

A relationship between entities describes how entities are associated. Relationships are represented by lines,
connecting entities. Relationship end adornments indicate multiplicities of these ends. Multiplicity is the number
of entity instances that can be associated with a number of another entity instances. Relationship multiplicity is
represented by three symbols (so called “crow's foot notation” or “Information Engineering notation” - see
Table 1 on page 7).

TABLE 1. Symbols of the relationship multiplicity

Name Value Notation
Zero Zero

o
Vertical One

Crow’s Many
foot <

Multiplicity lower bounds and upper bounds are paired into one adornment - see the possible pairings in
Table 2 on page 8. Note that any lower bound, which is more that O is treated as 1 (this also includes lower
bounds greater than 1 - such as e.g. 2). Also, any upper bound which is greater than 1 is treated as Many (this
also includes upper bounds less than unlimited - such as e.g. 7).




Business Entity-Relationship Diagrams

TABLE 2. Multiplicity bound pairings

Min Max Read As Figure
0 1 One (optional)
-Of
1 1 One (mandatory)
_H_
0 Many Many (optional)
-0
1 Many Many (mandatory)
==gntity== |f| Maote the number width specified
Person _|as type modifier
==PK==-id : NUMBER"(20, 0y~
-name : String
—currentReader Abstractly modeled entity, no
currentes EI? - — attribute infarmation shown
L -loanedBooks |<<entity=> -
__________ —04 Book

Figure 1 -- Basic ER diagram example

NOTES e Some authors use Entity Type term to signify the description of a set of entities and Entity
Instance term to signify concrete exemplar from that set. Entity term used in this manual
corresponds to Entity Type.

e Data modeling world frequently uses term Cardinality to denote the allowable numbers of
entity instances, which can be associated. But with the rise of the UML, the more correct
term Multiplicity was introduced and term Cardinality is only used to denote concrete
numbers of entity instances, which are associated. Hence in the example Person [0..1]------
-[0..¥] Book, the ranges [0..1] and [0..*] are called multiplicities. And if we have person “John
Doe” associated with books “Moby Dick” and “Origin of Species”, we have a cardinality of 2
for loaned books role (and 1 on an opposite end - current reader role). Note that cardinality
is always concrete number while multiplicity denotes range of possible cardinalities.

There is a flavor of the ER diagrams, called Business ER diagrams - this is a simplified flavor of the ER
diagram. This diagram only shows entities as boxes (without structure) and relationships between them. It is
useful for high-level, abstract domain modeling - provide a structure for business data, or define business

terminology.

These diagrams can be draw using the same ER diagram simply by suppressing both primary key and column
compartments on all the entities. Convenient way to do this is to multiselect all the entities (hold down ALT and
click any entity) and use the Suppress All button in the Shape Editing toolbar of the diagram.



Identifying Relationships and Dependent Entities

One-to-many (and, very rarely, one-to-one) relationship can be declared identifying. Identifying relationship is a
“stronger” version of the relationship, indicating that the one entity (the one at the multiple end of the
relationship) can not exist without the entity on the other end.

You can create such relationships using buttons on a diagram pallet. You can also turn an existing relationship
into identifying and back again. For this you can choose to do one of the following: either change the Is

Identifying property value in the relationship Specification window or select the appropriate check box on its
shortcut menu.

Identifying relationship is drawn as solid line. Non-identifying relationships use heavy dashes.

Closely related concept is dependent / independent entities. Dependent entities are those, which are at the
multiple end of the identifying relationship. They cannot exist without the independent entity at the other end. In
addition every inherited entity (if you are doing EER modeling) is considered to be dependent.

Dependent entity's primary key includes the other entity's key as part (this is implied, not shown in the model).

Dependent entities are automatically recognized and drawn with rounded corners.

Identifying Dependent Entity
relationship T
".
. | Mote that, hecause of the
L | idertifying relationship, primary
4 I key of Orderftem includes not
X I qnly _pl'nduct column but also
=entity== ' . =<entity== E‘ f':"“F'"E’d) POMr
PurchaseOrder U ' y Orderltem 7
==PK==-PONr : Integer " "{==PK==-product : Stringg”
-date ; Date -guantity ; Integer
“totalSum : Integer -unitPrice : Integer
-discount : MUMEBER"(3 3)" - g

Figure 2 -- Example of identifying relationship and dependent entity in ER diagram

You can place XOR constraints (there is also a rarely used OR constraint) between relationships using a
corresponding toolbar button. Note that constraint must join relationships, that have at least one common end -
not any arbitrary relationships.

Current implementation of constraints does not allow placing a constraint on more than 2 relationships.

ER diagram has a support for generalization / specialization modeling. Generalization and Specialization is
really the same relationship, just the different direction of classification (generalization is bottom-up,
specialization is top-down). Hence they use the same model element.



Generalization and Specialization

Generalizations can be joined into generalization sets (trees of generalizations), which allow specifying
additional properties on a group of generalizations - such as disjointness and completeness constraints.

==zgntity== E
Employee

S 2

1 [ 1
| [ |

==gntity== E ||==entity== E <=gntity== E | [==entity== E ||==entity== E
Technician

| Engineer Manager Salaried | Hourly

|
==<entity== E | qA | |
Secretary | | : I L |
==entity== E
| EngineeringManager | |

I Two separate generalization sets, describing two I
—paraleliseparate ways how to classify employee, and —

standalone generalization (not belonging to any

generalization set)

Figure 3 -- Example of generalization in ER diagram

Disjointness and completeness constraints are specified using the Is Disjoint (true for disjoint, false for
overlapping specialization) and Is Covering (frue for total, false for partial specialization) properties. They can
be set via the relationship shortcut menu or in the Specification window.



Generalization and Specialization

Hence there are 4 combinations of these two settings. The “breadloaf’ symbol joining generalizations into a
tree shows these 4 variations - see the following figures.

==entitys== E
Shape overlapping, partial

_|(this iz default)
==entity== E ==entity== E <=entity== E <=entity== E
Circle Square Rectangle Polygon

= I

™ e
~ | -

Sy
overlaps |

Figure 4 -- Example of overlapping and partial specialization in ER diagram

<<gntity=:=
UniversityMember overlapping, total

==gntity=:= E z=gntity== E
Student Staff

A

overlaps, because interns
belong to both students and
staff members

Figure 5 -- Example of overlapping and total specialization in ER diagram



Generalization and Specialization

a=gntity== E
Fruit digjoirt, partial

-

—_1

==gntity=:= E z=gntity== E ==gntity=z= E
Pear Grape Pineapple

Figure 6 -- Example of disjoint and partial specialization in ER diagram

a=gntity == E
Human digjoint, total
é -.-' -.-

==gntity== El a=gntity== E
Male Female

Figure 7 -- Example of disjoint and total specialization in ER diagram

NOTE UML terminology (covering / not covering) is used for completeness property name in
Specification window. Other names, more familiar for data modelers, are total / partial and
complete / incomplete. These terms are analogous and can be used interchangeably.

In the specialization hierarchies, there can be several ways how entity instance is assigned to specific entity
subtype. It can be determined by the user - when user himself decides to which subtype given instance belongs
(user-defined specialization). Or it can be determined by actual data values of entity instance (attribute-defined
specialization). The latter case can be further subdivided into two subcases - simple attribute-based
discrimination (when discrimination is performed by doing simple attribute value comparison) and more
complex predicate-based discrimination (when discrimination is specified using more complex, explicitly

specified conditions).



Generalization and Specialization

Examples of these two cases are shown in the following figures.

N

~ —Specify discriminating column(s)
inthe generalization set

==enumeration== ==ertity=> [ 4 specification

Sex Human s
M _ ! AN
F -E8X C Se / Specify attribute discriminators on

each generalization

z=gntitys=:= E
Female

Figure 8 -- Example of attribute-based discriminator in ER diagram

==zgntity== E
Tax Payer Specify predicate discriminators
on each generalization,

Mote that there is no need to
_gpecify digcriminating columns in

- - _this case
—_ - = - d

-income ; Integer

__:_--' oy — e - r
e o /s
— - - - A
fincome == 12000} {income =12000 AMD income == 60000} fincome = 60000}
==entity== E [ ==gntity== E] ==gntity==
Low Bracket Middle Bracket High Bracket

Figure 9 -- Example of predicate-based discriminator in ER diagram

Discriminators are modeled as special constraints, placed on individual generalization relationships. The
easiest way to access them is from the shortcut menu of the generalization.

Predicate-based discriminator is simpler - you just fill in the Specification field of the predicate with an
appropriate expression text.

Attribute-based discriminator is more complex. First you have to specify columns, by which you will discriminate

the entities into the corresponding subclasses. This is done by filling in the Discriminator field of the

generalization set (you can specify one or several columns there). Then you have to fill in the Template field of

the predicate. This template field holds an instance specification, which is used as template or etalon to
differentiate the entity instances into appropriate subclasses. Fill in the slots for the same columns that you
indicated on the generalization set.

NOTE Category (also know as union) concept is currently not explicitly sup-
ported. Total (but not partial) categories can be “simulated” using the total
specialization tree, just visually reversed.



Key Modeling

Keys of the entity are marked by applying the corresponding stereotype («PrimaryKey», «AlternativeKey») on
the necessary column(s). This can be done from the shortcut menu of the column.

==entitys== E
Person Person has primary key consisting of one
==PK==-ssn : String b — — — 7 T|column (ssn) and an aternative key consisting
of two columns (name, surname)

==MAK==-name ;. String
==fAK=>-surname . String

Figure 10 -- Example of key usage in ER diagram

Primary key columns are grouped into a separate compartment. When the «PrimaryKey» stereotype is applied
/ unapplied, the column migrates between the two compartments.

In rare cases there is a need to specify several alternative keys on the same entry. This can be done, by filling
the “Id” tag field of the key column with key identifier(s). Columns, having the same Id are considered to be
belonging to the same key. Overlapping alternative keys can be specified in the same manner (column can
have several ids specified).

==gntity=:= E
ShippingAddress ShippingAddress has primary key (id column) and
two alternative keys - addriconsisting of country,
I city, street and nr columns) and post{consisting of
==fAK==-courtry ; String{id = "addr, "post"} country and postalCode columns). Mote that
==fl==-city ;. String{id = "addr"} country column belongs to both keys
==fK=>-street | Stringfid = "addr}
== fP=onr o Stringfid = "addr'}
==fAK=>-postalCode | Stringfid = "post"}

==PH==-id . Integer

Figure 11 -- Example of multiple overlapping alternative keys in ER diagram

Inversion entries are specified analogously. Inversion entry is a non-unique (combination of) column(s), which
nevertheless is used frequently to search for the entity. Marking columns as IE gives hints to database
implementers about which indexes to specify.

==entity==
InvenmtoryPartType
==PH==-code . String

=<|E==-names : String

Figure 12 -- Example of inversion entry in ER diagram

NOTE Though ER profile carries the «ForeignKey» stereotype, this stereotype is cur-
rently unused. It is reserved for future - for automatic foreign key derivation
functionality. Users should not specify FK columns explicitly on their entities
(FKs are implied), unless needed for some specific purpose - use at your own
risk.

Virtual entities are entities that can be derived from information in other entities. They are marked with keyword
«virtual» on the diagrams. Otherwise they can be handled in the same manner as other entities.



Importing CA ERwin® Data Modeler Projects

Virtual entities roughly correspond to views in databases.

If you need to specify exact way how virtual entities are derived from other entities, you can use Abstraction
relationships from UML,; derivation expression can be specified in the Mapping field.

==yirtual==
SalesReport

==PH==-year . Integer
==PH==-morth : Morth

-zales ; Integer

| AN
| Mapping expression can be show in a diagram using
| note symbol:
-:;-:;abgtrac‘tigrl!::;: | Mapping = SELECT flk_salesmanid, year,
- month, sumitotal) as sales
| FROM Purchase
GROLUP BY flk_salesmanid, year, month

|
|
= .‘ll.

==gntity== E i ==gntity== E‘ ==entity==
Salesman Purchase . I Product
==PK==-id : String C ==PK==-PONr : String i "=<PK==-id ; String
-name ; String -guantity : Integer -unitPrice : Integer
—gucta ; Integer -priceywithDiscount ; Integer
-total : Integer
-year | Integer
-morith : Month
-day ; Integer
Y, ’,

Figure 13 -- Example of virtual entity usage in ER diagram

Cameo Data Modeler Plugin for MagicDraw provides import functionality for data models created using CA
ERwin® Data Modeler (henceforth will be referred as ERwin). ERwin is one of the leaders in the data modeling
tools market.

Data models produced in ERwin have a two-layer structure consisting of logical and physical layers that are
tightly synchronized. The physical layer semantically corresponds to the SQL modeling / diagramming /
generation functionality in MagicDraw. The logical layer corresponds to ER diagrams, implemented by Cameo
Data Modeler Plugin.

The import functionality only imports logical layer data from ERwin into ER diagrams / data model in

MagicDraw. Cameo Data Modeler Plugin does not yet support import of physical layer data.

Importing Data Models

Cameo Data Modeler supports model files produced in ERwin version 7.x. It is recommended that the newest
v7.3 should be used since it has been heavily tested. Data models in ERwin must be saved in the *.xml format
(choose the XML Standard File option in the Save As dialog).



Importing CA ERwin® Data Modeler Projects

To import an ERwin model

1. Start MagicDraw.
2. Click File > Import From > CA ERwin Data Modeler v7.x. The Open file dialog will open.

3. Select an ERwin model file (*.xml). A new MagicDraw project will be created and logical model
will be imported from the ERwin model file into that project.

After successful import, you can proceed to edit or manage the model using MagicDraw features.

If you want to include the ER model as part of a larger project in MagicDraw, you can use either module linking
functionality (click File > Use Module) to attach the ER model to your main project model or project import
functionality (click File > Import From > Another MagicDraw Project) to transfer the contents of this ER
model to your main project model.

If you want to update an imported and edited ER model, for example, you have made changes to the ERwin
model and want to import those changes into MagicDraw again, you can use the merge functionality (click
Tools > Project Merge) to import the ERwin model into a new ER model and merge it with the model you have
imported earlier.

Imported Elements
TABLE 3. Import Mapping Reviews and Notes

ERwin Cameo Data Comments
Modeler
Any element Any Element e For each element, it's name, definition, and notes are
imported.

e Definitions are imported as MagicDraw documentation
(special UML comments) and notes are imported as
UML comments.

Entity Entity
Attribute Attribute e The Null / Not Null setting is imported as UML
multiplicities [0..1] / [1].
e Attribute constraints and default value information is
imported.
e Domain information is not imported because domains
are not supported.

e Attribute type information is imported - the standard
primitive types are mapped to the UML primitive types.

e Other types (which are not found in the model) are
created on the fly.

Key Key Marking on e There is no separate standalone model element for a
Attributes key in the Cameo Data Modeler ER diagrams. Instead,
attributes belonging to a key are marked by applying a
stereotype to them (PK, AK, or IE) as necessary.

Relationship Association e Simple relationships are mapped to UML associations.
relationship e Verb phrases are mapped to role names.

e Cardinality and null / not null settings are mapped to
UML multiplicities ([0..1], [1], [0..%], [1..*]).

e Referential integrity information is stored in a special
stereotype / tag.

e Key information is not imported since the current ER
diagrams do not support FK modeling.



Importing CA ERwin® Data Modeler Projects

ERwin

Default Value

Domain

Validation Rule
Display

User Defined
Properties
Dictionary

User Defined
Properties

Cameo Data
Modeler

Generalization
relationship

Instance
Specification

Constraint
ER diagram

Profile / Stereotypes
/ Tags

Tag Values

Comments

ERwin relationships, which are participating in the
generalization tree, are mapped to UML
generalizations.

Generalizations are joined into generalization trees.

Complete / incomplete and overlapping / exclusive
settings are imported / supported.

Discriminating columns are imported / supported.

Referential integrity information is stored in a special
stereotype / tag.

Verb phrase information is not imported.

A standalone UML instance specification is created to
hold value definition. This instance specification is (or
can be) then referenced from attributes, default value
fields.

Domains are not yet supported in Cameo Data
Modeler.

The Validation rule is stored as constraint body text.

Due to geometric constraints and element size
changes, the diagram layout will be slightly different.

Paths between elements can be re-routed.

A custom UML profile is created for the user's property
definitions.

A custom profile generated from the UDP dictionary is
applied and user property information is stored in the
tag values of the applied custom stereotypes.



DATABASE SUPPORT

Cameo Data Modeler plugin brings the following:

IMM Relational profile for SQL modeling support (the profile is named according to the OMG
working group name).

Extension profile for Oracle.

SQL diagram, Oracle SQL diagram and customizations for profile.

Code engineering (generation / reverse) features for working with database generation scripts.
Primitive type libraries for database flavors.

Template for new Database project creation.

Sample, demonstrating database modeling features.

UML / ER to SQL (Oracle and generic) and SQL to UML transformations and accompanying
traceability features.

Entity-Relationship and SQL report.
Helper functionality for SQL diagrams - notation switch.

Cameo Data Modeler plugin provides support for database modeling and code engineering. It supports
modeling of the database concepts at the level of SQL:1999 (SQL3) standard. A few rarely used concepts (like
collation, translation) are not supported.

IMPORTANT!

A BIG DISCLAIMER UPFRONT. In v17.0.1 SQL modeling was significantly extended and
reworked. The new profile for SQL modeling covers more SQL concepts than the old
Generic DDL and Oracle DDL profiles, that were previously used for SQL modeling. How-
ever the code engineering features (script generation and reverse engineering) were not
upgraded yet - code engineering capabilities are almost the same as in v17.0. There is cur-
rently a skew between the modeling and code engineering features. Some things that can
be modeled with the help of the current profile can not yet be not generated / reversed to /
from database script.

Cameo Data Modeler provides a specialized diagram for database modeling. This diagram is called SQL
Diagram and is located under Data Modeling diagram subgroup. This diagram provides means for creating
and depicting various SQL elements.

In addition to the main SQL diagram, there is a slightly modified diagram for Oracle databases. It is called
Oracle SQL Diagram and is located under the same Data Modeling diagram subgroup. This diagram is only
slightly modified - it has an additional diagram button for the Materialized View modeling. Otherwise than that,
it is identical to the main SQL diagram. If you are not modeling materialized views, you can freely use the
generic diagram type instead of specialized one for Oracle modeling.



Database Modeling

Crow’s Foot Notation in SQL Diagrams

Once Cameo Data Modeler plugin is applied to MagicDraw you can display the crow’s foot notation or use

standard UML notation of associations (displaying multiplicities in text format) in the SQL diagram.

To display Multiplicities or crow’s foot notation in a SQL diagram

. Create the SQL diagram.

. Draw two tables.

. Create columns for the tables and some of them as primary keys.
. Connect the table elements with the Foreign Key relationship.

. Open the Project Options dialog box.

. Select the General

project options branch.

1
2
3
4
5. Define Name, PK, and FK in the open Foreign Key dialog box.
6
7
8

. Change the Show relationship ends as property correspondingly to either No special

notation or Crow’s feet. Multiplicities (Figure 14 on page 19) or crow’s foot notation (Figure 15

on page 19) will then be displayed on the Foreign Key ends.

==tahble==
ORDER

==not null== ==PH==-0ORDER_ID : integer
==not null==-CORDER_DATE : date
-FH_CUSTOMER : integer

fFl columns = FK_ORDER,
Fl columns = ORDER_ID}

==table==
ORDERED _ITEMS

==not null== ==PK==-ORDER_ITEM_ID : integer
-Fli_ORDER : integer

-FH_ITEM : integer

==not null==-ITEM_COUMT © integer

Figure 14 -- Multiplicities on Foreign Key relationship in SQL diagram

==tahble==
ORDER

==not null== ==PH==-0ORDER_ID : integer
==not null==-CORDER_DATE : date
-FH_CUSTOMER : integer

=2=F k==

Fl columns = ORDER_ID}

==table==
ORDERED _ITEMS

o
Pk columns = FK_ORDER,

==not null== ==PK==-ORDER_ITEM_ID : integer
-Fli_ORDER : integer

-FH_ITEM : integer

==not null==-ITEM_COUMT © integer

Figure 15 -- Crow’s foot notation for Foreign Key relationship in SQL diagram

This chapter covers modeling of various SQL elements - in detail and with examples.

Common SQL Element Properties

These properties are common and available for all SQL model elements in their Specification windows.

Property name Description

Name Name of this SQL model element.

Label Label of SQL model element. Can be used for various referring

purposes (both human and code referral).

Description Longer text, describing this SQL element in more detail.



Database Modeling

Property name Description

TODO Additional remarks about the further modifications, necessary for this
element

In addition to these SQL properties, some common, useful UML model properties are shown in the
Specification windows (only in the Expert mode).
Property name Function

Qualified Name  Fully qualified name of this model element - names of all owning parent
elements and this element, concatenated using “::” separators.

Owner Model element, directly owning this element.
Applied Stereotypes, applied on this model element, extending element data
Stereotype over and above the standard UML functionality. SQL extension

stereotypes can be seen here (implementing SQL model features,
described in this document) as well as any additional extensions.

Image Custom image can be set on each model element if necessary.

Top Level Elements

There are several top-level model elements, that serve as the containers for other model elements of the
database model. Those are: Database, Schema, Catalog.

Top level elements are not strictly necessary to begin database modeling. You can start modeling database
elements (like tables) in the standard UML package (even directly under root ‘Data’ model element). But top
level elements help to provide context for those other elements and their naming and positioning in the
database. So, at least one top level element should be present - either Schema element or Database element.
Optimally both Database and Schema element should be present in the model (Schema package inside the
Database package). Catalog modeling is less important, it can be skipped. Not all databases have support for
catalogs.
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When top-level element is created (either on the diagram or in the containment tree), a special dialog is shown
for selecting database flavor.

P® Select DB Type [i_E-J

Cloudscape/Derby
De2

Microsoft Access
Microsoft SQL Server
MySQL

Oradle

Pervasive

PointBase
PostgreS0L
Standard SQL

Sybase

[ oK | | Cancel

Figure 16 -- Database flavor selection dialog

When DB flavor is chosen, the necessary profile for that DB flavor is attached to the project (providing standard
data types for that DBMS and / or additional stereotypes for modeling extensions of that DB flavor). Then profile
application relationship is created from the package that is being created (Database, Schema) to the attached
DB profile. This marks the top level element as belonging to this DB flavor, Other DB elements, created under
that top level element will be automatically considered as belonging to this DB flavor.

If you would like to switch database flavor after creating a top level element, you can do this in the following
way.

To switch database flavor after creating a top level element

IMPORTANT! You must have the necessary module attached to your project (use File>Use Module
menu, choose the necessary module from your <install.root>\profiles predefined loca-
tion)

1. Right-click the top level element.

2. From the shortcut menu, select Apply Profiles.

3. Select the check box near the needed profile and clear the check box near the old profile.
4. Click Apply.
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Top level elements can be explicitly drawn, on the diagram.

zDatabases E|
Enterprise
zSchemaz Es
Sales

zGlobalss B ztables
GLOBALS Purchase
zzedz-IDGenerator = {0 +1} aColz epk=-id : integer
: : : : acolz=-fiProduct © integer
cproca+Selll prod © integer, amount © integer, price © numeric"{10,27" )

=funcz+SalesFarMonth( month : date ) : numeric"{10, 2)"

A eFKs

-procuct
atables
Product
zcols eplkz-id | integer

Imembers = iProduct,
referencedMembers = id}

Figure 17 -- Database top level containers (Database and Schema) on diagram pane

However, showing top level elements on the diagram, and nesting their contents inside them is often clumsy,
and consumes valuable diagram space. Showing them on the diagram pane is not necessary; it is enough to
create them in the Containment tree (using the New Element command on the shortcut menu). Then, place
your diagram inside the created containers, and the elements that you will be creating in your diagram, will go
into the necessary container. See the following figure (logically equivalent to the previous one), showing a top
level element just in the Containment tree and not displayed on the diagram pane.
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Figure 18 -- Database top level containers (Database and Schema) in Containment tree, but not on diagram pane

There is also one additional complication, steming from the limitations of UML. UML does not allow placing
UML properties (which are used for SQL sequence modeling), or operations (which are used for SQL stored
procedure & function modeling) directly into packages. Properties and operations can only occur in classes. A
special model element was introduced to work around this limitation - GLOBALS element (based on UML
class). This intermediate element can be placed directly inside the top level element (usually Schema, but can
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also be placed under Database) and then the necessary database elements - sequences, stored procedures
can be placed inside it.

Database

NOTE Database is modeled as UML Package with Database stereotype
applied.

Database is a top level element, representing entire database within DBMS.

Besides the standard SQL element properties, database has the following properties available in the
Specification window:

Property name Description

Vendor Specifies the vendor and the version of the database software. These
Versi fields are used for information purposes only. They do not affect the
ersion . .
generation or further modeling.
Schema
NOTE SQL Schema is modeled as UML Package with Schema stereotype

applied.

Schema element represents a collection of database elements - tables, indexes, stored procedures, etc. -
grouped for particular purpose (such as data structures for some particular application).

Catalog

NOTE SQL Catalog is modeled as UML Package with Catalog stereotype
applied.

Catalog element represents intermediate grouping level between database and schema. Catalogs are also
reused for Oracle DB modeling - to implement Oracle packages.

GLOBALS

NOTE GLOBALS is modeled as UML Class with the «Globals» stereotype
applied.

GLOBALS element is a special intermediate element to work around limitation of UML. UML does not allow
placing UML properties (which are used for SQL sequence modeling), or UML operations (which are used for
SQL stored procedure & function modeling) directly into packages. Properties and operations can only occur in
classes.

To work around this limitation, GLOBALS element (based on UML class) was introduced. This intermediate
element can be placed directly inside the top level element (usually Schema, but can also be placed under
Database) and then the necessary database elements - sequences, stored procedures and functions can be
placed inside it.

Name of GLOBALS model element is not important, but for the sake of tidiness it should be named
“GLOBALS". There should be at most one such element per the container (Schema, Database, Package). This
model element does not carry any additional useful properties; it serves just as a carrier of inner elements -
sequences and routines.



Database Modeling

Tables, Columns, and Views

Tables and their constituent columns are the main elements for describing database data structures. Table
stores multiple rows of data each consisting of several columns. Each cell holds one data value (or is empty).
All values of one column are of the same type. Correspondingly each table description consists of the table
name and a set of column descriptions. Additionally there are various kinds of constraints (including the all-
important primary key and foreign key constraints), that can be applied on tables and triggers, specifying
additional actions to be performed during data manipulation.

See “Constraints” on page 37 for constraints and “Triggers” on page 45 for triggers.

There can be various kinds of tables
e Normal persistent tables
e Temporary tables
e Views (derived tables)

The following figure illustrates various kinds of tables that can be modeled on the diagram.
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col=-gales ; numeric"(10, 27" scol=-month : smallint

Figure 19 -- Various kinds of tables: persistent tables, temporary tables, and views
Tables can have generalization relationships between them. These relationships correspond to the following
SQL syntax in the create table statement:

CREATE TABLE <name> OF <UDT name> [UNDER <supertable>]
There can be at most 1 outgoing generalization. Generalizations are not widely supported in database

management systems. As of v17.0.1 Cameo Data Modeler supports modeling of these structures. Generation
of corresponding script code is not supported yet.
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Persistent Table

NOTE SQL Persistent Table is modeled as UML Class with the «Persistent-
Table» stereotype applied. For the sake of compactness, these tables
are displayed with the «table» keyword (instead of the long form -
«PersistentTable») on the diagram.

Persistent table is the most often used kind of table.

Besides the standard SQL element properties, persistent table has the following properties available in the
Specification window (these properties are only available in Expert mode).

Property name Description

User-defined Points to structured user defined type, which serves as a base for the
type row type of the table.
Supertable Points to the parent (base) table. Can only be used together with user-

defined type.

Self Ref Column Describes the self-referencing column generation options. Can only be
Generation used together with user-defined type. Corresponds to the following
subclause of SQL create table statement:

REF IS <column name> [SYSTEM GENERATED|USER
GENERATED|DERIVED]

Referencing This is back reference from foreign keys, referencing this table. This field

Foreign Keys is for information purposes only. If you want to change it, change
Referenced Table field of the foreign key instead.

Insertable These are two derived (non editable) fields, describing table data editing

Updatable capabilities. At the moment calculation of these properties is not

implemented - they are always set to false

Temporary Table

NOTE SQL Temporary Table is modeled as UML Class with the « Temporar-
yTable» stereotype applied. For the sake of compactness, these tables
are displayed with the «temporary» keyword (instead of the long form -
«TemporaryTable») on the diagram.

Temporary table is a kind of table, where data is held only temporary. There are two kinds of temporary tables.
Local temporary table persists for the duration of user session and is visible only for the creator user. Global
temporary table is long lived and visible for all users. Note that data in the global temporary table is different for
different users and does not persist throughout user sessions (only global table definition persists).

Temporary tables are created using SQL create table statement (using TEMPORARY option):
CREATE (GLOBAL | LOCAL) TEMPORARY TABLE <table name> ...

[ON COMMIT (PRESERVE | DELETE) ROWS]

Besides the standard SQL element properties and persistent table properties (see section above), temporary
table has the following properties available in the Specification window.

Property name Description

Local Marks the table as local or global temporary table.

Delete On Regulates whether data is deleted or retained on commit.
Commit
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View

NOTE SQL View is modeled as UML Class with the «ViewTable» stereotype
applied. For the sake of compactness, views are displayed with the
«view» keyword (instead of the long form - «ViewTable») on the dia-
gram.

View is a table, whose data is derived from data of other tables (by applying some SQL query).

Views are created using SQL create view statement:

CREATE VIEW <name> [<view column list>]
AS <query expressions
[ WITH [ CASCADED | LOCAL ] CHECK OPTION ]

Note that since column definition list is optional in SQL syntax, specifying column definitions in the view is also
optional (columns can be inferred from query expression of the view). However it is often a good idea to include
column definitions, since this allows to see view data structure on the diagram / in the model at a glance,
without parsing the query expression text.

Besides the standard SQL element properties and persistent table properties (see section above), view has the
following properties available in the Specification window

Property name Description

Query A query expression, defining how data is calculated / retrieved for this
Expression view. This is an SQL SELECT statement.
Check Type Describes how check is performed on the data update through the view.

Only meaningful for updateable views (which is rare).

Query expression of the view modeling deserves a special attention. Query expression, defining the view, is not
just a simple string, but a (stereotyped) UML model element. By default query expression model object is
stored within the view definition itself. There is a special constraint, automatically created inside the view, to
hold this expression. When the view is created, Query Expression field (which is a tag of stereotype, applied
on the view) is automatically pointed to this expression.

So by default you just need to fill in the Body text of the expression. To do that you need to double-click on the
Query Expression field. This opens Specification window for the expression itself, where Body can be filled in.
This is the default, no-hassle way to specify view. It is easy. But it has one deficiency. Views created this way do
not have any model references to the underlying table model elements. This may be undesirable from the
dependency tracking standpoint (in the dependency analysis). To remedy this, you can draw an additional
Dependency relationships between the view and base tables.

There is also another way to model the query expression, defining the view. If you click on the ... button of the
Query Expression field, this action opens the element selection dialog, allowing to retarget the Query
Expression pointer choose another expression object, located somewhere else in the model. For example
view definition expression can be located inside the Abstraction relationship, drawn from the view to the base
table (Mapping field of the Abstraction).

To model view queries using abstractions

1. Draw an abstraction relationship between a View and a Table.

2. In the abstraction’s Specification window, fill in the Mapping cell. This will be an inner UML
OpaqueExpression model element with language and body cells. Set language to “SQL” and fill
in the body with the necessary “SELECT ...” expression text.

3. Further open the Specification window of the mapping expression, and apply the
«QueryExpressionDefault» stereotype.
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4. Open the Specification window of the view. Click the ... button in the Query Expression cell. In

the element Selection dialog navigate to the abstraction relationship and select the expression
inside of it.

This way to model view query expressions is rather tedious - so it is not recommended for modeling novices.
But it has an advantage of capturing the real relationship in the model between the view and the constituent

table(s). Also query expression can be shown on the abstraction relationship (using note mechanism) instead
of showing expression on the view.

In the following figure you can see a diagram that illustrates the alternative way of view modeling.
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SalesReport'
IqueryExpression = SELECT
seumitotalPrice) as sales, year, manth
FROM Purchase GROUP BY year, month}
col=-gales : numeric"(10, 21"
colz-year : smallirt
colz-month : smallint

Figure 20 -- Alternative notation for modeling view derivation from tables

Column

NOTE SQL Column is modeled as UML Property with «Column» stereotype
applied. For the sake of compactness, columns are displayed with the
«col» keyword (instead of the long form - «Column») on the diagram.

Column model element describes one column of the table. In the most frequent case it's just a name of the
column and a type. Additionally column can carry default value specification, column constraints.

Column definition syntax in SQL (in CREATE TABLE, ADD COLUMN statements):

<column name> [ <data type> ]
[ DEFAULT <value expressions> |
GENERATED { ALWAYS | BY DEFAULT } AS IDENTITY
[ ‘(' <sequence options> ‘)’ ] |
GENERATED ALWAYS AS <expression>]
[ <column constraint definition>... ]
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Besides the standard SQL element properties, column has the following properties available in the
Specification window.

Property name Description

Type Collectively these two fields describe the type of the column. Type could
be any of the primitive types from the library or user defined type.
Modifier provides additional parameters for the type - such as width of
the character type (when type=varchar and modifier="(20)" - column is
of varchar(20) type). See Type Usage section for details.

Type Modifier

Nullable Marks column as nullable or not. Basically this is an in-line nullability
constraint. See Constraints section for details.

Default Value Carries the default value of the column. This is normally an opaque
expression, allowing to specify the value of the column. However it can
be switched to Identity Specifier. In this case it describes the
autoincrement options of the column. See Sequences section.

Is Derived Standard UML field, used to mark the column as derived (GENERATED
ALWAYS AS <expression>). It works together with Default Value field.
Scope Check Marks this column as scope checked to a particular table and allows

choosing particular referential integrity ensuring action (RESTRICT
CASCADE, etc).

Implementation  Marks this column as implementation dependent.
Dependent

Scope Checked

Modeling Types

Cameo Data Modeler provides the standard type libraries as well as ability to model user defined types
(structured user defined types and composites - multiset, array data types). The types can then be used to
specify columns of the tables and / or parameters of procedures and functions. There is also a special
mechanism for using types with modifiers. This mechanism is common in the MagicDraw, however some
explanation is necessary on how to use it in database modeling.

Predefined Type Libraries

Cameo Data Modeler provides predefined type libraries for database flavors it supports. Besides the standard
SQL type library, there are type libraries for Oracle, DB2, MS SQL, MySQL, PostgreSQL, Sybase, Cloudscape
(Derby), Pervasive, MS Access and Pointbase. The standard SQL type library is the main type library, and type
libraries for each flavor import (a subset of) types from it and define additional types, specific for that flavor.

The necessary type library is imported when you create the Database or Schema element in your model and
choose a flavor for it (See Database flavor selection dialog: “Database flavor selection dialog” on page 21).
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Type Usage
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Figure 21 -- Type specifying. Library type and modifier vs. separately modeled type

Usage of a simple SQL type, such as boolean, is very simple. If you want to set it as a type of a column or
operation parameter, you just need to specify it in the type field. However there are types (such as varchar or
numeric) in SQL, which require additional data. There are two mechanisms to specify these kinds of types:
either use the library type+ type modifier mechanism or create your own type element.

Lets take the standard varchar type as an example. It must have the maximum length data provided at each
usage. Semantically there are many different types, one for each length limit - varchar(20), varchar(53),
varchar(255) etc. Now the standard type library can not provide myriad of different varchar types. Library only
provides the varchar type definition.

To specify that column is of varchar(20)

1. Set the type field of the column to varchar type from the library.

2. Set the type modifier field of the column to “(20)” (no quotes). Note that type modifier is a
simple string - whatever is entered in this field, will be used in script generation verbatim,
without additional checks. An example of more complex type modifier would be “(10, 2)” type
modifier for numeric data type.

Alternative way to specify that column is of varchar(20) is to explicitly create a separate type in the model.
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To specify that column is of varchar(20) in the alternative way

1. Create the necessary type (use one of the buttons in the SQL diagram, Primitive Types toolbar)
- character string, fixed precision, integer, approximate, boolean, binary, date or XML types. In
our case this would be character string type.

2. Set the length data in the dedicated tag (look up the length tag in the Tags section of the
Specification window). Note that this is numeric field - you need to input number 20, and not the
“(20)” string as was the case with type modifiers.

3. The name of your type can be whatever you like. For example varchar_of_20. The name is not
important.

4. Inherit (draw generalization relationship) your type from the appropriate type from the type
library. In this case, inherit varchar_of_20 from varchar form the library. This information will be
used for determining the proper type name during script generation (so, in the generated script
you will see the proper type reference - varchar(20)).

5. This created type can now be specified in the type field of the column(s).

There would be one type in the model for each varchar length that you use in your database.

The second way is more tedious - you need to create quite a few types. So by default the first way is used. But
the second way has several advantages, that may outweight it's deficiencies. First - there is one spot where
parameters of the type can be changed. You can easily widen the varchar(20) fields to varchar(40) by editing
just one place in the model. Secondly, you can define some additional parameters of the type - such as
character set.

User Defined Types
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Figure 22 -- Examples of user defined types
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Besides the primitive / built-in types of the database, user can define additional types for his own schema.

Distinct Type

NOTE SQL Distinct type is modeled as UML DataType with «DistinctUserDe-
finedType» stereotype applied. For the sake of compactness, refer-
ences are displayed with the «distinct» keyword (instead of the long
form - «DistinctUserDefinedType») on the diagram.

Distinct type definition allows to redefine some primitive type in order to enforce the non-assignability rules. For
example, two distinct types Meters and Yards can be defined on the base primitive type float. With this
definition, system would enforce checks that yard fields / columns are not assigned to meter fields / columns
without a conversion (explicit cast).

Besides the standard SQL element properties, distinct type has the following properties available in the
Specification window.

Property name Description

Predefined Points to some base primitive type.
Representation

Domain

NOTE SQL Domain is modeled as UML DataType with «Domain» stereotype
applied. For the sake of compactness, domains are displayed with the
«domain» keyword on the diagram.

Domain allows to define a more narrow set of values than the base primitive type allows. This narrowing is
done by assigning additional constraints on the domain. Columns, whose types are set to the domain, can only
assume values from this more narrow subset.

Besides the standard SQL element properties, domain has the following properties available in the
Specification window.

Property name Description

Predefined Points to some base primitive type.
Representation

Default Value Default value for the column if no value is specified.

Structured User Defined Type

NOTE SQL Structured User Defined Type is modeled as UML DataType with
«StructuredUserDefinedType» stereotype applied. For the sake of com-
pactness, domains are displayed with the «structured» keyword
(instead of the long form - «StructuredUserDefinedType»)on the dia-
gram.

Structured UDT defines a composite datatype. Each value of this type is a tuple of several values; each position
in a tuple has a name. Structured UDT value is analogous to one row of the table. Structured UDTs allow single
inheritance (multiple inheritance is not supported). Inheritance (subtype-supertype relationship) can be
modeled using UML Generalization relationships
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Besides the standard SQL element properties, structured UDT has the following properties available in the
Specification window.

Property name Description

Instantiable Defines
Final Default value for the column if no value is specified.
Super Shows base data types. This is a derived field, it is not editable. To make

changes, use UML Generalization relationships.

Parts of the structured UDT (properties) are called attributes (compare - parts of the table definition are called
columns). Attributes of structured UDT are created like columns of the table, that is, via the Attribute
Definitions tab in the structured UDT Specification window or using an appropriate smart manipulation button
on its shape.

Besides the standard SQL element properties, attribute has the following properties available in the
Specification window.

Property name Description

Type Collectively these two fields describe the type of the attribute. The same

Type Modifier considerations as for column type modeling apply.

Default Value Carries the default value of the attribute.

Scope Check Marks this attribute as scope checked to a particular table and allows
choosing particular referential integrity ensuring action (RESTRICT

Scope Checked CASCADE, etc).

Besides attributes, Structured UDTs have a collection of methods - operations, performing actions on values of

this type. Methods are covered in a separate section with stored procedures and functions (see Routines
section).

Array Type

NOTE SQL Array type is modeled as UML DataType with «ArrayDataType»
stereotype applied. For the sake of compactness, arrays are displayed
with the «array» keyword (instead of the long form - «ArrayDataType»)
on the diagram.

Array type defines an array (that is, list of values, with the indexed, O(1) access to the n-th element) of the
values of elementary type.

Besides the standard SQL element properties, array type has the following properties available in the
Specification window.

Property name Description
Element The elementary type of the set elements.

Max Cardinality = The size limit of the array.
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Multiset Type

NOTE SQL Multiset type is modeled as UML DataType with
«MultisetDataType» stereotype applied. For the sake of compactness,
multisets are displayed with the «multiset» keyword (instead of the
long form - «MultisetDataType») on the diagram.

Multiset type defines a set of elements of the elementary type.

Besides the standard SQL element properties, multiset has the following properties available in the
Specification window.

Property name Description
Element The elementary type of the set elements.

Reference Types

NOTE SQL Reference type is modeled as UML DataType with «Reference-
DataType» stereotype applied. For the sake of compactness, refer-
ences are displayed with the «ref» keyword (instead of the long form -
«ReferenceDataType») on the diagram.

Reference type defines a pointer to the data of the referred type.

Besides the standard SQL element properties, reference type has the following properties available in the
Specification window:

Property name Description
Referenced Type The type of the data that is being referenced.

Scope Table Limit the references to the data of the particular table.
Row Type
NOTE SQL Row Data Type is modeled as UML DataType with

«RowDataType» stereotype applied. For the sake of compactness, row
data types are displayed with the «row» keyword (instead of the long
form - «RowDataType») on the diagram.

Represents one row of the table. The difference from structured UDT is that row type represents a value stored
in the table, while structured UDT represents “free-floating” value during computation. For example it is
meaningful to take address for the row., but not of the structured UDT value.

Parts of the row data type (properties) are called fields (compare - parts of the table definition are called
columns). Fields for row data type are created like columns of the table, that is, via the Fields tab in the row
data type Specification window or using an appropriate smart manipulation button on its shape.

Besides the standard SQL element properties, field has the following properties available in the Specification
window.

Property name Description

Type Collectively these two fields describe the type of the field. The same

Type Modifier considerations as for column type modeling apply.
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Property name Description

Scope Check Marks this field as scope checked to a particular table and allows

Scope Checked CASCADE, etc).

Sequences and Autoincrement Columns

choosing particular referential integrity ensuring action (RESTRICT

NOTES e SQL Sequence is modeled as UML Property with «Sequence»
stereotype applied. For the sake of compactness, sequences are
displayed with the «seq» keyword (instead of the long form -

«Sequence») on the diagram.

e Autoincrement parameters (start value, increment, etc.) data is
stored as a separate model element - UML OpaqueExpression, with
«ldentitySpecifier» stereotype applied. This element is set as
defaultValue of the Property - either sequence property (when
standalone sequences are modeled) or column property (when

autoincrement table columns are modeled).

SQL has facilities to generate sequences of numbers (0, 1, 2, 3, ...). These sequences are often used to fill in
values for identifier columns - to uniquely number the row data in the table. There are 2 separate facilities:

e Standalone sequence object. This generator is not tied to any other object. Programer must
explicitly query it to get the next value from the sequence and then use the retrieved value
appropriately (usually in the INSERT statement to insert value for id column). Usually there are
separate sequences for each table; sometimes the same sequence is reused for several

columns.

e Autoincrement columns. Column of the table can be designated as autoincrement. When row
is inserted into the table, if value of such column is not explicitly provided, one is generated

automatically.

zGlobalse B atables

GLOBALS Product
seqz-PurchaseTablelDGenerator = {0 +1 H' colz eph=-id ; integer = {0, +1}

L
LY e
o~
A -
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N, =
-

Autoincrement column and
standalone seguence ohject

Figure 23 -- Example of sequence and autoincrement column modeling

Cameo Data Modeler has modeling support for both kinds of sequences.

To create a standalone sequence

Do one of the following:

e Select the GLOBALS element shape on a diagram pane and click an appropriate smart

manipulation button.
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e Right-click the GLOBALS element in the Containment tree and on its shortcut menu, select
New Element > Sequence.

NOTE Since a standalone sequence is modeled as a UML Property, it can not be
placed directly into the Schema package.

Autoincrement columns are also supported. To mark a column as autoincrement, you must switch the Default
Value property value type from value expression to identity specifier.

To mark a column as autoincrement

1. Open the column Specification window.
2. Select the Default Value property.

3. Click the black-arrowed button next to the property value and select Value Specification >
IdentitySpecifier as shown in the following figure.
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Scope Checked ] <undefined =
Scope Chedk

0,40 ®

) Default Value - : : : : :

Open Specification
I Common : :
Name ” Select in Containment Tree
Label ¥ | Delete Opagque Expression Value Specification .
_IEE:sD:::pton 1#*  IdentitySpecifier
3 TdentitySpecification (¥  OpaqueExpression «ValueExpressionDefault= || ||| [F -

Figure 24 -- Marking column as autoincrement
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After the switching, the Autoincrement property group appears in the Specification window of the column
allowing to specify autoincrement data (start value, increment, etc.).

P* Primary Key Member - id —

Specification of Primary Key Member properties
Specify properties of the selected Primary Key Member in the properties specification
table, Choose the Expert or All options from the Properties drop-down list to see more
properties,

ﬂi

T
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-id : ANSI SCL Type Libregl!

_ Usage in Dia.grams Bl oAl [y B B Properﬁes::smndard v:
Documentation/Hype
| Tags B Primary Key Member

Canstraints Type E inkeger [ARST SOL Type Library]
----- 5 Language Properties Type Modifier
Mullable [ <undefined =
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@Efﬁult Value {0, +1} -]
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Bl In Check Constraint
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m
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Figure 25 -- Additional properties in autoincrement column’s Specification window

Besides the standard SQL element properties and sequences, an autoincrement column has the following
properties available in the Autoincrement property group of the Specification window.

Property name Description

Start Value Starting value of the sequence counter.
Increment Delta value of the sequence counter (can be negative - to count down).
Minimum Lower bound of the counter (if any).
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Property name Description
Maximum Upper bound of the counter (if any)

Cycle Option The counter can “wrap around” when it reaches the maximum (or
minimum - for downwards counters)

Additionally sequence has an Identity field and column has the Default Value field, where textual
representation of the counter options can be entered. This feature can be used for nice displaying of the
counter configuration in the diagrams (the start, inc, min, max field data is normally not visible in the diagram).
Some notation convention should be adopted how to map the counter data into the text representation. For
example it could be: {<start>, <inc>, <min>-<max>, <c>}. Then the counter from 0 with +1 increment, min max
of 0 and 1000 and cycle option would be displayed as “{0, +1, 0-1000, C}” string. At the moment this text
representation is not automatically connected to the counter field values, so synchronization has to be done by
hand.

Constraints

Tables have a multitude of constraints between them. These constraints enforce the proper business semantics
for the data in the database tables (relationships between data in different tables, semantical constraints of the
data in the table). There are these available constraint types:

e Primary key constraints - specifying column (or a combination of columns), which uniquely
identify the row in the table.

e Unique constraints. They are very similar to primary key constraints - uniquely identify the row
in the table. One of the unique constraints of the table is designated as primary.

e Foreign key constraints, which establish relationships between two tables.

e Nullability constraints (NOT NULL constraint) - a simple constraint on the column, indicating
that column must have value

e Check constraints establish additional checking conditions on values in the column / table.
e Assertions provide more global check than a check constraint - spanning multiple tables

e indexes are not constraints per se, but they are covered in this section because they are
modeled similarly.

The primary keys, unique and check constraints, indexes can be modeled in two ways. One way is easy and
simple but does not cover all the options provided by SQL. Another way is tedious, but provides full SQL
coverage.
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Implicit Primary Key, Unique, Check Constraint, and Index Modeling

NOTES e SQL Primary Key (when implicitly modeled) is modeled as an
additional «PrimaryKeyMember» stereotype applied on the SQL
column. This variant is shown in the diagram as an additional «pk»
keyword on the column in the diagram.

e SQL Unique Constraint (when implicitly modeled) is modeled as an
additional «UniqueMember» stereotype applied on the SQL column.
This variant is shown in the diagram as an additional «unique»
keyword on the column in the diagram.

e SQL Check Constraint (when implicitly modeled) is modeled as an
additional «CheckMember» stereotype applied on the SQL column.
This variant is shown in the diagram as an additional «chk» keyword
on the column in the diagram.

e SQL Index (when implicitly modeled) is modeled as an additional
«IndexMember» stereotype applied on the SQL column. This variant
is shown in the diagram as an additional «idx» keyword on the
column in the diagram.

An easy way of modeling this kind of constraint is applying the «PrimaryKeyMember», «UnigueMembery,
«CheckMember», or «IndexMember» stereotype on the necessary column. PK, unique, and index markers can
be applied on the column via its shortcut menu as shown in the following figure.
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++ « | Prirary Key Member
: : . Member of Unigue

Figure 26 -- Quick application of PK, Unique, and Index markers
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To apply a check constraint marker on a column

1. Open the Specification window of the column.
2. Define the Condition property value in the In Check Constraint property group.

Thusly marked column is considered as a member of one-column constraint, specified in-line. It is by default an
unnamed constraint. To specify its name, you need to define the Primary Key Name, the Unique Key Names,
the Check Name, or the Index Names property value in the column Specification window.

In the SQL script (in CREATE TABLE, ADD COLUMN statements) this would correspond to the following part of
the column specification:

<column name> [ <data type> ]

[ [<constraint name>] <constraint>... ]
<constraint> ::=

| UNIQUE| PRIMARY KEY

| CHECK ' ('<conditions>')"

If primary key, unique constraint or index must span several columns (in this case constraint is not in-line, near
the column definition, but as a separate definition at the bottom of the table definition), all the columns must be
marked with the appropriate «UniqueMember» / «IndexMember» stereotype and all must have the same name.
Column can participate in several unique or

Various cases of quick constraint modeling are depicted in the following figure.
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col=-aptMo : varchar inline
check condition
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Figure 27 -- Various situations, modeled with quick constraint notation
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Explicit Primary Key, Unique, Check Constraint, and Index Modeling

NOTES e SQL Unique Constraint (when explicitly modeled) is modeled as UML
Constraint with «UniqueConstraint» stereotype applied.

e SQL Check Constraint (when explicitly modeled) is modeled as UML
Constraint with «CheckConstraint» stereotype applied.

e SQL Index (when explicitly modeled) is modeled as UML Constraint
with «Index» stereotype applied.

The quick, implicit way to model constraints does not cover some cases, allowed by SQL. Constraints in SQL
can be marked as DEFERABLE, INITIALY DEFERRED; constraint in the database can be in active state
(enforced) or disabled. Indexes have various configuration parameters.

Modeling with the help of «xXYZMember» stereotypes does not allow to specify this additional information. In
this case modeling with explicit constraint model elements is necessary. This can be done from the
Specification window of table. There are separate tabs for creating these constraint elements: Unique
Constrains (allows creating both primary keys and unique constraints), Check Constraints, Indices. Once
created, additional properties of the constraints can be specified.

Besides the standard SQL element properties, primary key and unique constraint have following properties
available in the Specification window.

Property name Description

Members Columns, constrained by this constraint (must come from the same table
where constraint is located)

Inline Whether constraint is defined near the column definition, or separately,
at the bottom of the bale definition. Only one-column constraints can be
inline.

Deferable Marks the constraint as deferrable.

Initially Deferred Marks the constraint as initially deferred.

Enforced Whether constraint is actively checked in the database (can be changed
with the SQL statements).

Check constraints have the same properties as primary key and unique constraints, and additionally have
following properties available in the Specification window.

Property name Description

Condition Condition to be checked

Besides the standard SQL element properties, index has the following properties available in the Specification
window.

Property name Description

Members Member columns of this index

Member For each member column, ASC or DESC ordering direction
Increment Type

Unique Index is used to enforce uniqueness

System Index is system-generated.

Generated
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Property name Description

Clustered The index is clustered. Only one index per table can be clustered. Non-
clustered indexes are stored separately and do not affect layout of the
data in the table. Clustered index governs the table data layout (table
data pages are leafs of the index tree).

Fill Factor Hash table fill factor of the index

Included Additional member columns of the index. No sorting is done by these
Members columns, however their data is included into index - this provides fast
Included retrieval. This feature is very database-specific (AFAIK only MS SQL
Member Server has those).

Increment Type

Foreign Keys

NOTES e SQL Foreign Key (when modeled with UML Association relationship)
is modeled as UML Association with the «FK» stereotype applied.on
the end of the association (UML Property), which points to the
referenced table

e SQL Foreign Key (when modeled with UML Constraint) is modeled as
UML Constraint with «ForeignKey» stereotype applied.

stables A aFK=z tables
Person' -Person-Address Address’

col=-id ;. numeric"(10, 03" -id : numeric"{10 23"
col=-name : varchar™ 00" -fkPersoniD : numeric"(10 07"
col=-surname ; varchar'{100}" -Zip : varchar

-country : varchar

-state . varchar

-city : varchar

-street . varchar

-streetMo : varchar

-aptho : varchar

{members = fkPersanlD,
referencedMembers = id}

Figure 28 -- Foreign key example

Foreign keys describe relationships between two tables. At the detailed understanding level, foreign key is a
constraint on the (group of) columns in the source / referencing table, such that for each row in the source table
their value combination (tuple) is equal to the value combination (tuple) of the (group of) columns for some row
in the target / referenced table.

Foreign keys also have the two ways to be modeled. The main way is described below.
The main way to model foreign keys is to draw association relationship from the referencing table to the

referenced table. The relationship can be simply draw in the diagram from the smart manipulator or from the
button in the diagram toolbar.



Database Modeling

When the FK association is draw, the following dialog pops up:

Ll " " " Leany
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Mame Person-Address

Figure 29 -- Foreign Key dialog

Note that you have to have the necessary columns in the tables (PK or unique columns in target table,
referencing FK columns in the source table) before drawing the FK relationship. In this dialog, select the
referenced columns (of the target table) in the first column of the table, and corresponding referencing columns
(of the source table). Additionally, foreign key name can be specified.

When dialog is OK’d, foreign key association is created; «FK» stereotype is applied on the referencing
association end and the selected column information is stored in tags.

If foreign key information has to be changes, this is done in the Specification window of the FK property.
Besides the standard SQL element properties foreign key has the following properties available in the
Specification window.

Property name Description

Inline The same functionality as for the explicitly modeled PK, unique
constraints

Deferable

Initially Deferred

Enabled

Match Specifies how the columns in the referenced table and columns in the
referencing table are matched (SIMPLE, FULL, PARTIAL match).

On Delete Referential integrity enforcement action that is performed when the data

in the referenced table is deleted (NO ACTION, RESTRICT, CASCADE,
SET NULL, SET DEFAULT)

On Update Referential integrity enforcement action that is performed when the data
in the referenced table is updated (NO ACTION, RESTRICT,
CASCADE, SET NULL, SET DEFAULT)

Referencing Member columns of the constraint (from the same table where constraint
Members is located). FK constrains values of these columns to point to the data in
the referenced tables
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Property name Description

Referenced The set of the columns in the referenced (target) table, to which
Members referencing columns are matched. There are 6 ways to specify this set -
Referenced choose one.

Table Referenced Members field explicitly lists the target columns.
Referenced Referenced Unique Constraint / Index points to the constraint or index in
Unique the target table, and referenced member columns are members of this
Constraint constraint / index.

Referenced (by  (by Name) option is used when constraint / index is no explicitly
Name) Unique modeled with model element but is just a marking on the column

Constraint . o

Referenced Table always points to the target table of the FK (field is not
Rei_’erenced editable, to change it, reconnect the association). If the referenced
Unique Index members column list is not specified in any other way, then referenced
Referenced (by columns are taken from the PK of the referenced table

Name) Unique
Index

The alternative way of modeling a foreign key is creating a UML constraint with the «ForeignKey» stereotype
applied. This way is less desired than the main way, because it does not visualize relationship between tables.
It is just a constraint in the table. This method may be used when human-readability is not critical, e.g., when
database layout is generated with some custom automated script / transformation in the model.

To create a constraint with the «ForeignKey» stereotype

1. Select a table in the Containment tree.

2. Do one of the following:
e Right-click the selected element and from its shortcut menu select New Element >
Explicit Foreign Key.

e Open the Explicit Foreign Keys tab in the table’s Specification window.
Besides the standard SQL element properties and properties that are available for other explicit constraints
(that is, PK, unique, check constraints), explicit foreign key has the following properties available in the
Specification window.

Property name Description

Match Specifies how the columns in the referenced table and columns in the
referencing table are matched (SIMPLE, FULL, PARTIAL match).
On Delete Referential integrity enforcement action that is performed when the data

in the referenced table is deleted (NO ACTION, RESTRICT, CASCADE,
SET NULL, SET DEFAULT)

On Update Referential integrity enforcement action that is performed when the data
in the referenced table is updated (NO ACTION, RESTRICT,
CASCADE, SET NULL, SET DEFAULT)

Referencing Member columns of the constraint (from the same table where constraint
Members is located). FK constrains values of these columns to point to the data in
the referenced tables
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Property name

Referenced
Members

Referenced
Table

Referenced
Unique
Constraint

Referenced (by
Name) Unique

Description
The set of the columns in the referenced (target) table, to which

referencing columns are matched. There are 6 ways to specify this set -
choose one.

Referenced Members field explicitly lists the target columns.

Referenced Table field just specifies the target table, referenced
columns are then taken from the PK of the table

Referenced Unique Constraint / Index points to the constraint or index in
the target table, and referenced member columns are members of this
constraint / index.

Constraint L N . .
(by Name) option is used when constraint / index is no explicitly
Referenced modeled with model element but is just a marking on the column

Unique Index

Referenced (by
Name) Unique

Index
Nullability Constraint
NOTE SQL NOT NULL constraint (if modeled explicitly, which is rare!) is

modeled as UML Constraint with «NotNullConstraint» stereotype
applied.

Nullability, or NOT NULL constraint forces the condition that the column must have value. Implicit NOT NULL
constraint is modeled with the nullable field of the column (set nullable=false to specify NOT NULL). This is an
usual and quick way to model these constraints.

Usually there is no need to model these constraints explicitly - create a separate model element for them. But
in the more complex cases these constraints can be created by hand and the «NotNullConstraint» stereotype

applied on them. This allows specifying non-inline constraints, or named constraints, or deferred constraints or
inactive constrains.

NOT NULL constraint does not have any additional properties in the Specification window besides the
properties that all table constraints have.

Assertion

SQL Assertion is modeled as UML Constraint with «Assertion» stereo-
type applied.

NOTE

Assertion constraints are very similar to check constraints, but instead of being local to the table, they are
global to the database. Assertions check some condition that must hold through several tables. Assertions are
modeler as explicit constraints; there is no shorthand modeling form - assertion is always an explicit UML
constraint.

To create an assertion

1. Select a schema or a database element in the Containment tree.
2. Right-click the selected element and from its shortcut menu select New Element > Assertion.
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Besides the standard SQL element properties assertion has the following properties available in the
Specification window.

Property name Description

Search The assertion body condition

Condition

Constrained List of the tables on which assertion runs

Tables

Triggers

NOTE SQL Trigger is modeled as UMLOpaqueBehavior with the «Trigger»

stereotype applied.

Trigger describes some action that must be performed when some particular data manipulation action is being
performed in the database table. Trigger can be fired when data is added, deleted or changed in the table and
perform some action (update some other table, calculate additional values, validate data being updated or even
change the data that is being updated).

Trigger is always defined for some table. You can define triggers in the Triggers tab of the table Specification
window. Trigger has an event type (on what actions trigger is fired, that is, on insert, on update, or on delete),
action time (before, after, instead of), and an actual body describing the actions.

Besides the standard SQL element properties, trigger has the following properties available in the Specification
window.

Property name Description

Specifies moment of time when trigger action is performed (before the
specified event, after event, insteadof event).

Action Time

On Insert
On Update
On Delete

Trigger Column

The event that causes trigger firing.

List of columns, which cause trigger fire on update (must be from the
same table as trigger is located). Used with On Update triggers to
specify that only some column updates cause trigger fire.

Language Trigger implementation language (should be SQL).

Body Trigger body text (operations that are performed on trigger fire)

Time Stamp Trigger creation timestamp

Action Specifies whether trigger fires once per executed statement, or once per
Granularity each affected row

When Specifies additional precondition for trigger firing

New Row These fields can be used for defining variable names for holding new
New Table L%v;; table values and old row / table values - for referencing in trigger
Old Row REFERENCING ((NEW|OLD) (TABLE[ROW) AS <name>)+

Old Table

Additional Additional action statements. This option is rarely used - it is non-
Actions standard and supported only by some databases. Usually triggers have

just one body.
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Routines
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Figure 30 -- Routines example

SQL supports several different kinds of routines. There are global routines, that are not bound to a particular
type but belongs to the schema. There are two kinds of these routines - Procedures and Functions. And there
are routines, that are bound to a particular structured user defined type - Methods. Each routine kind can have
several parameters. Parameters have type and direction (in, out, inout). Functions and methods in SQL have
return types - this is formalized in UML models by having an additional parameter with return direction kind.

There is an UML limitation, that UML does not allow to place UML operations (which are used to model SQL
procedures and functions) directly in the UML packages (which are used to model SQL schemas). For this
reason global routines are placed into a special container class - GLOBALS (see “GLOBALS” on page 23).

Routines can be external (written in some other languages and attached to database engine) or SQL routines.
In the latter case, body of the routine can be specified in the model. Due to UML specifics, there are two ways
to specify the routine body - by filling the UML method field or by filling the UML bodyCondition field of the
operation. These two ways are visible in the Specification window under the field names Source (as method)
and Source (as body condition). When specifying routine body, specify only one of these fields.

To use “as method” way

1. Right-click the GLOBALS element in the Containment tree and from its shortcut menu select
New Element > Source. A source element (a UML OpaqueBehavior with the «Source»
stereotype applied) under the GLOBALS element will be created in your schema.

2. In the Specification window of routine, edit the Source (as method) property value and in the
opened dialog select the source element you've just created.
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To use “as body condition” way, you simply have to fill the field. The routine body model element (in this
caseUML Constraint - holding UML OpaqueExpression) shall be created under your routine model element.

Besides the standard SQL element properties, all 3 kinds of routines have the following properties available in
the Specification window.

Property name Description

Specific Name Additional name for the routine, uniquely identifying it throughout the
system.

Deterministic Specifies whether routine is deterministic (always gives the same output
with the same data input)

Parameter Style SQL or GENERAL

SQL Data Specifies how routine accesses SQL data (NO SQL | CONTAINS SQL |
Access READS SQL DATA | MODIFIES SQL DATA)

Source(as Fields holding routine body text (chose only one).

method)

Source (as body

condition

Creation TS Routine creation and last edit timestamps

Last Altered TS

Authorization ID Authorization identifier which owns this routine (owner of the schema at
routine creation time)

Security Determines the authorization identifier under which this routine runs.
Tipically set to “INVOKER”, “DEFINER”, “IMPLEMENTATION
DEPENDENT”

External Name The name of the external language routine implementation method (if
routine is non-SQL routine)

Procedure

NOTE SQL Procedure is modeled as UML Operation with «Procedure» ste-
reotype applied. For the sake of compactness, procedures are dis-
played with the «proc» keyword (instead of the long form -
«Procedure») on the diagram.

Procedure is an operation that can be SQL-invoked and performs some actions depending on the parameters
supplied. Procedures are global for schema - they are created under the GLOBALS model element.

Besides the standard properties of SQL routines (see “Routines” on page 46), procedure has the following
properties available in the Specification window.

Property name Description

Max Result Sets If result set count returned by procedure is dynamic, this value limits
count thereof (DYMANIC RESULT SETS <max> clause)

Old Save Point  Savepoint level indicator for procedure (false means that new savepoint
must be established before the procedure is run)
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Function
NOTE

SQL Function is modeled as UML Operation with «Function» or
«BuiltinFunction» or «UserDefinedFunction» stereotype applied. By
default the «UserDefinedFunction» is used, however if another kind can
be freely used if it is necessary for modeling needs (e.g. if we are
modeling some built in library and want to specify that functions are
built-in and not user defined).

For the sake of compactness, functions are displayed with the «func»
keyword (instead of the long form) on the diagram.

Function describes some operation that calculates and returns some value depending on the parameters
supplied. Functions are global for schema - they are created under the GLOBALS model element.

Besides the standard properties of SQL routines (see section above), function has the following properties
available in the Specification window.

Property name
Null Call

Type Preserving

Transform
Group

Method
NOTE

Description

Specifies that function returns NULL when called with NULL parameter
value (RETURNS NULL ON NULL INPUT clause)

Specifies that function does not change the type of the supplied
parameter (returns the same object)

Allows to specify TRANSFORM GROUP <groups> clause - single or
multiple.

SQL Method is modeled as UML Operation with «Method» stereotype
applied. For the sake of compactness, methods are displayed with the
«func» keyword (instead of the long form - «Method») on the diagram.

Method is a function of the structured user defined type. It is created inside the structured UDT.

Besides the properties of SQL functions (see section above), method has the following properties available in
the Specification window.

Property name

Constructor

Overriding

Parameter
NOTE

Description

Specifies that function is a constructor (that is, it is used to construct
values of the enclosing structured UDT).

Specifies that function is overriding the same-named function from the
parent structured UDT

SQL Parameter is modeled as UML Parameter with «Parameter» ste-
reotype applied.

This model element specifies data inputs / outputs into routine calculations. Parameter has a type, direction (in
/ out / inout for usual parameters and a single parameter with direction return for functions) and default value.
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Besides the standard SQL element properties, parameter has the following properties available in the
Specification window.

Property nhame Description

Type Type of the parameter

Type Modifier

Default Value Default value (used when value is not supplied during routine
invocation).

Direction Direction of data flow through the parameter (into the routine, out of the
routine or both)

Locator AS LOCATOR modifier of the type. Specifies that instead of value,
means to locate value are transferred

String Type Only valid when parameter type is XML type. Specifies underlying string

Option datatype.

Cast Type Additional options, specifying that return parameter is cast from another

Cast Locator type (possibly with locator indication).

Cursor and Routine Result Table

NOTE SQL Cursor is modeled as UML Parameter with the «Cursor» stereo-
type applied.

When routine does not return a scalar value but a collection of the table values, cursor is used, instead of the
parameter. Cursor has a type. This type must be some table type instead of the scalar types used for
parameters. It can be an actual table / view from the model, if cursor returns values from that table, or (if cursor
returns data from some SELECT statement) can be a synthetic table. A Routine Result Table model element is
used for this purpose (UML Class with «RoutineResultTable» stereotype applied). It's modeling is exactly the
same as the normal tables - this is just an ephemeral table.

Besides the standard SQL element properties, cursor has the following properties available in the Specification
window:

Property name Description

Type Type of the cursor. Should point to the routine result table.

Type Modifier

Direction Direction of data flow through the parameter (into the routine, out of the
routine, routine result)
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Access Control
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Figure 31 -- Access control example

SQL has means to specify and control the rules of access to various data objects. This subset of SQL language
is sometimes called Data Control Language. The relevant concepts are: User, Group, Role (3 different kinds of
authorization subjects), Permission and Role Authorization (2 kinds of access control rules). Possible object
types for access control varies depending on database flavor, but usually Tables, User-defined Types,
Domains, Routines, Sequences can be specified as the target objects of access control.

User
NOTE SQL User is modeled as UML Actor with the «User» stereotype applied.

User object represents the single user person in the system, User is subject to access control rules.

Besides the standard SQL element properties, user has the following properties available in the Specification
window.

Property name Description
Owned Schema Schemas that are owned by this user,

Group

NOTE SQL Group is modeled as UML Actor with the «Group» stereotype
applied.

Group object represents a collection of Users. Group is subject to access control rules, and allows specifying
access control rules on several users simultaneously.

Besides the standard SQL element properties, group has the following properties available in the Specification
window.

Property name Description
User Collection of users the group is made of.

Owned Schema Schemas that are owned by this group,
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Role
NOTE SQL Role is modeled as UML Actor with the «Role» stereotype applied.

Role object represents a specific role (typical activities) that can be played by users. Role is subject to access
control rules, and allows specifying access control rules for all subjects, playing this role.

Besides the standard SQL element properties, role has the following properties available in the Specification
window.

Property name Description
Owned Schema Schemas that are owned by this role,

Privilege

NOTE SQL Privilege is modeled as UML Dependency with the «Privilege» ste-
reotype applied.

Privilege relationship expresses the fact that the permission to perform specified action on specified object
(relationship target) is granted to specified grantee (relationship source). Grantee can be any authorization
subject - Use, Group or another Role. Object can by another SQL object (the precise list of object types, that
can be targeted by privileges, varies by database type).

Privilege corresponds to SQL grant privilege statement:
GRANT <action>[(<column list>)] ON <object> TO <grantee> [WITH HIERARCHY
OPTION] [WITH GRANT OPTION]

Besides the standard SQL element properties, privilege has the following properties available in the
Specification window.

Property name Description
Action Specifies action that is being granted (such as SELECT or UPDATE).

Action Objects Specifies additional more narrow subobject list, on which the specified
action is permitted (usually column list for SELECT or UPDATE).

Grantable Specifies that this privilege can be further re-granted to other subjects by
the recipients. Corresponds to WITH GRANT OPTION part of GRANT
statement.

With Hierarchy  Specifies that this privilege applies to subobjects (subtables).
Corresponds to WITH HIERARCHY OPTION part of the GRANT

statement.
Grantor Subject, who grants this privilege to the grantees.

Role Authorization
NOTE SQL Role Authorization is modeled as UML Dependency with «RoleAu-
thorization» stereotype applied.

Role authorization relationship expresses the fact that the specified role (relationship target) is granted to
specified grantee (relationship source). Grantee can be any authorization subject - Use, Group or another Role.

Role authorization corresponds to SQL grant role statement:
GRANT <role> TO <grantee> [WITH ADMIN OPTION]
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Besides the standard SQL element properties, role authorization has the following properties available in the
Specification window.

Property name Description

Grantable Specifies that this role can be further re-granted to other subjects by the
recipients. Corresponds to WITH ADMIN OPTION part of GRANT
statement.

Grantor Subject, who grants this role to the grantees.

Oracle Database Modeling Extensions

When the Oracle flavor is chosen for database top level element (schema or database), additional Oracle
extensions are brought in. Elements that are in the scope of this schema or database element obtain additional
Oracle-specific properties in the Specification windows (under the separate Oracle property group). These
properties carry an additional information, that is then used when generating DDL scripts for Oracle.

Most often there is just one Additional Properties property - allowing entering free-form text that is then used
when generating (this can be used to specify any extension texts - such as tablespace options for tables).

Oracle extensions provide means to model synonyms. Synonym is mapped as follows:

e Element of the same type (that is, table, materialized view, stored procedure, sequence) as the
one being aliased is created. It is stereotyped as appropriate, but have no other data - just it's
name is important.

e Additionally, stereotype «OraSynonym» will be applied on the element. It has ref:Element[1]
tag for pointing to the element being aliased. Synonyms of synonyms are handled in the same
way.

Oracle extensions provide means to model materialized views. Materialized view can be created from Oracle
SQL diagram. It is an ordinary SQL view, but with the additional «OraMaterializedView» stereotype applied (in
diagrams, a shortened keyword «materialized» is used for the sake of compactness).

Cameo Data Modeler provides code engineering capabilities database script generation and reverse
engineering. Database model can be generated in to the DDL script, which can then be run on the database
engine to create database structures. And conversely database engine can export database structures into the
DDL script, which can then be reverse-engineered into the database model. In addition to that Cameo Data
Modeler provides reverse engineering directly from live database through JDBC connection.

Cameo Data Modeler code engineering supports the following database dialects for script generation and
reversing:

e Standard SQL
e Oracle

e MS SQL Server
e DB2

e MySQL

e PostgreSQL

e Sybase
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As was mentioned earlier, database modeling was significantly extended in the version v17.0.1. But database
code engineering has remained at the same level as before. Hence currently not all database concepts, that
can be modeled, can be subsequently generated or reverse engineered. This situation will be amended in the

future.

Pervasive
Cloudscape / Derby
MS Access
Pointbase

Code Engineering Set

Code engineering set for database scripts can be created in the same manner as CE sets for other code types
(see “Code Engineering Sets” in MagicDraw CodeEngineering UserGuide.pdf). Right-click the Code
engineering Sets, New, DDL, and then the appropriate database flavor. When the CE set is created, database
model elements can be added to it and then DDL script file(s) can be generated OR the script files can be
added to the CE set and then reverse-engineered into the database models. In addition to reversing from files,
there is Reverse from DB radio button. Once it is switched, the options for JDBC connection configuring

appear, allowing to set up connection to the live database.

Box name

Recently
Used

DB

Connection
URL

Driver Files

Driver Class

Username
Password

Catalog

Schema

Description

Contains the list of the recently used reverse templates. Choose the one
you need and click Apply.

The connection URL for the selected profile.

Contains .jar and .zip files or directories with JDBC driver’s classes.

To choose the files or directories you want to add or remove, click the ...
button. The Select Files and/or Directories dialog appears.

NOTE If the driver file is empty, Driver Class is searched from
the classpath.

Contains the connection driver class.

Click the ... button and the list of available driver classes that are

available in the selected driver files is displayed.

NOTE Only in the files that are selected in the Driver Files list,
the system searches for driver classes.

Type the username to connect to the database.

Type the password to connect to the database.

Contains a name of the selected Catalog.

To retrieve the list of available Catalogs from the database, click the ...
button and select the catalog. The catalog name appears in the Catalog
text box.

NOTE Only when all other properties in this dialog box are

correctly defined, the list of catalogs can be retrieved.

Contains a name of the selected Schema.

To retrieve the list of available Schemas from the database, click the ...
button and select the schema. The schema name appears in the
Schema text box.

NOTE Only when all other properties in this dialog box are
correctly defined, the list of schemas can be retrieved.
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Box name Description
Property The name of the JDBC driver property.
Name

NOTE: If using Oracle drivers, while retrieving db info from Oracle db:

e To retrieve comments on table and column, set property as
remarks=true.

e To connect to a db as sysdba, set property as internal_logon=sysdba.

Debug JDBC If selected, all output from a JDBC driver will be directed to Message
Driver Window.

Reload Driver By default, the Reload Driver check box is selected. If you want that
driver to not be reloaded, clear the check box.

Properties of Code Engineering Set for DDL

There are two separate properties sets, stored as properties of code engineering set for DDL:
e Properties for DDL script generation

e Properties for DDL script reverse engineering

[ cG Propetties Editor x|
| Relations | Subobjects
g =
Colurmn default nullabiliky dialect default -

Create catalog seks current ... krue
Create schema sets current 5., krue
Default attribute multiplicity

Default catalog name Mone
Default schema narme Mo
Drop skatements Deferred
Generate Mull conskraink krue

Generate extended index name False
Generate extended trigger na. .. False
- . : . : p=

O, | Cancel | Help |

Figure 32 -- DDL properties in CG Properties Editor dialog

Property name Value list Description
Properties for DDL generation

Default attribute 0,0..1, any entered by If the attribute multiplicity is not
multiplicity user specified, the value of this property is
used.
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Property name

Generate Null
constraint

Generate extended
index name

Generate extended
trigger name

Generate index for
primary key

Generate index for
unique

Generate not Null
constraint

Generate qualified
names

Generate quoted
identifiers

Value list

True, false (default)

True, false (default)

True, false (default)

True (default), false

True (default), false

True (default), false

True (default), false

True, false (default)

Description

If true, generates NULL constraint for
column attribute with [0..1] multiplicity.
If DBMS, you use, support NULL, you
can enable this to generate NULL
constrains.

See also: GenerateNotNullConstraint,
AttributeDefaultMultiplicity

If true, generates index name of the
form: TableName_IndexName.

If true, generates trigger name of the
form: TableName_TriggerName.

If the DBMS, you use, requires explicit
indexes for primary key, you may
enable explicit index creation using
this flag.

See also: GeneratelndexForUnique

If the DBMS, you use, requires explicit
indexes for primary key or unique
columns, may enable explicit index
creation using this flag. See also:
GeneratelndexForPK

If true, generates NOT NULL
constraint for column attribute with [1]
multiplicity. If you set
GenerateNullConstraint, you may wish
to do not generate NOT NULL
constrain.

See also: GenerateNullConstraint,
AttributeDefaultMultiplicity

If value of Generate Qualified Names
check box is true, package name is
generated before the table or view
name.

For example: «Database» package
“MQOnline” includes «Table» class
“libraries”. Then check box Generate
Qualified Names is selected as true in
generated source would be written:

CREATE TABLE MQOnline.libraries;

Then check box Generate Qualified
Names is selected as false, in
generated source would be written:

CREATE TABLE libraries;
Specifies whether DDL code generator

should generate quoted names of
identifiers.
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Property name Value list

Description

Object creation mode The Object Creation Mode combo box has the following

options:

only CREATE statements
DROP & CREATE statements
CREATE OR REPLACE statements (only for Oracle dialect;

default for this dialect)

DROP IF EXISTS & CREATE statements (only for MySQL
dialect; default for this dialect).

Properties for DDL script reverse engineering

Dialect default
nullability (default), not
specified, NULL,

Column default

NOT NULL

Create catalog sets
current catalog

Create schema sets
current schema

Default catalog name DefaultCatalogNone

(default),

DefaultCatalogPack
age, any entered by

the user

Default schema name DefaultSchemaNone

(default),

DefaultSchemaPack
age, any entered by

the user

Drop statements

Map Null / not Null
constraints to

Map foreign keys

Map indexes

Map triggers

True (default), false

True (default), false

Deferred (default),
Immediate, Ignored

Stereotypes
(default), Multiplicity

True (default), false

True (default), false

True (default), false

If column has no NULL or NOT NULL
constraint specified, the value of this
property is used.

Specifies whether create catalog
statement changes current catalog
name.

Specifies whether create schema
statement changes current schema
name.

Specifies current database name.
Used when DDL script does not
specify database name explicitly.

Specifies current schema name. Used
when DDL script does not specify
schema name explicitly.

Specifies whether execution of drop
statements may be deferred, or must
be executed, or must be ignored.
Deferred drop may be enabled if
elements are recreated later. This will
save existing views. Attribute
stereotypes, multiplicity and default
value always are not dropped
immediately.

When parsing DDLs, the null / not null
constraints are modeled as either
stereotype tag values or multiplicity.

An association with «FK» stereotype
on the association end is created, to
represent Foreign Key.

A constraint with «Index» stereotype is
added into table, to represent index.

An opaque behavior with «Trigger»
stereotype is added into table to
represent trigger.
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Property name Value list Description

Map views True (default), false A class with «ViewTable» stereotype is
created to represent view.

Supported SQL Statements

This section lists SQL statements that are supported in the Cameo Data Modeler plugin. They are parsed and
mapped into model constructs.

The following table provides SQL2 SQL schema statements and their support status in the Cameo Data
Modeler plugin (Yes means that a statement can be generated into DLL script from model constructs and
reverse engineered from script into model constructs).

SQL schema statement Supported (Yes / No)
SQL schema definition Schema definition Yes
statement Table definition Yes
View definition Yes
Alter table statement Yes
Grant statement No
Domain definition No
Assertion definition No
Character set definition No
Collation definition No
Translation definition No
SQL schema manipulation Drop table statement Yes
statement Drop view statement Yes
Revoke statement No
Alter domain statement No
Drop assertion statement No
Drop domain statement No

Drop character set statement No
Drop collation statement No

Drop translation statement No

Some SQL schema statements (e.g. schema definition, table definition) allow implicit catalog name and
unqualified schema name. In addition to SQL schema statements, the following SQL session statements must
be supported:

e Set catalog statement - sets the current default catalog name.

e Set schema statement - sets the current default unqualified schema name.

Cameo Data Modeler supports the following widely used by dialects statements that are not the part of SQL2:
e Database definition statement (CREATE DATABASE) that creates database
e Index statements (CREATE INDEX, DROP INDEX) that create an index on table and remove it

e Trigger statements (CREATE TRIGGER, DROP TRIGGER) that create a trigger on table and
remove it.
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The following table provides details on mapping on the supported SQL schema manipulation statements into

SQL constructs.

DDL Statement or Concept Action, model Description Visible
Item
Alter table statement Modify class Elements: table name and alter table Yes
action. Alter table action — one of: add
column, add table constraint, alter
column, drop table constraint, drop
column.
Add column definition Define attribute  Elements: column definition. Yes
Add table constraint Define method  Elements: table constraint definition. Yes
definition
Alter column definition Modify attribute  Elements: mandatory column name, Yes
default clause (for add default statement
only).
Drop table constraint Delete method  Elements: constraint name, drop Yes
definition behavior
Drop column definition Delete attribute  Elements: column name, drop behavior  Yes
Drop schema statement Delete package Elements: schema name, drop behavior Yes
Drop table statement Delete class Elements: table name, drop behavior Yes
Drop view statement Delete class Elements: table name, drop behavior Yes
Drop behavior Action property  Modifiers: CASCADE, RESTRICT No

DDL Dialects

This section reviews Cameo Data Modeler support for DDL script flavors from different vendors.

Standard SQL2

For SQL2 statements supported by Cameo Data Modeler see Section Supported SQL Statements, “Supported
SQL Statements”, on page 57.

MagicDraw UML schema package is located within a database package. Database definition statement is not
the part of the SQL2 standard - it is an analogue of a Database (a Catalog).

NOTE A Catalog has no explicit definition statement. If a database package
for a Catalog does not exist, it should be created (when it is referred for
the first time).

Oracle

Cameo Data Modeler Oracle DDL script generation is based on the Velocity engine. This provides ability to
change generated DDL script by changing velocity template. In this chapter we will introduce how Oracle DDL
generation works in MagicDraw, how to change template for some specific things.

Knowledge of the Velocity Template Language is necessary for understanding, editing, or creating templates.
Velocity documentation can be downloaded from: http://click.sourceforge.net/docs/velocity/Velocity-
UsersGuide.pdf.

For more information about Oracle DDL generation and customization, see MagicDraw OpenAPI
UserGuide.pdf.
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Oracle dialect

For more information about Oracle DDL 11g, see http://download.oracle.com/docs/cd/B28359 01/ server.111/
b28286/toc.htm

Oracle dialect has CREATE DATABASE, CREATE INDEX, and CREATE TRIGGER statements that are not the
part of SQL2 standard but that are taken into account while reversing DDL script of this dialect.

This dialect has some syntax differences from SQL2 standard because of extensions (e.g. some schema
definition statements can have STORAGE clause). These extensions are ignored while reversing.

Code engineering features for Oracle dialect are more extensive that code engineering for other dialects. In
addition to the concepts, supported by Standard SQL generation, Oracle generation supports generation and
reverse of:

Sequences

Synonym

Structured user-defined types (with methods, map & order functions)

Function and Procedure

Users, Roles Grants

Materialized Views

Cloudscape

Informix Cloudscape v3.5 dialect has no database definitions statement. A database package with the name
specified by CurrentDatabaseName property is used.

This dialect has CREATE INDEX and CREATE TRIGGER statements that are not the part of a SQL2 standard
but that should be taken into account while reversing DDL script of this dialect.

This dialect has some syntax differences from SQL2 standard because of extensions (e.g. some schema
definition statements can have PROPERTIES clause). These extensions are ignored while reversing.
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NOTE Transformation engine implementation code is available from the
MagicDraw Standard Edition upwards. However, there are just a couple
of transformations in the MagicDraw (Any-to-Any and Profile Migration
transformations). The Cameo Data Modeler plugin brings in a set of
transformations between various kinds of data models.

The Cameo Data Modeler plugin for MagicDraw provides a set of transformation for transforming between
various kinds of data models. There are transformations for transforming:

e UML models to SQL models (2 flavors - generic and Oracle)

e ER models to SQL models (2 flavors - generic and Oracle)

e SQL models to UML models (suitable for all flavors of databases)
e UML models to XML schema models

e XML schema models to UML models

After the transformation, user can further refine the resulting model as necessary, and generate the artifact files
from those models. Actual DDL scripts, XML schema files can be generated using the code engineering
facilities.

Since the Cameo Data Modeler plugin provides more powerful modeling and generation features for Oracle
database flavor (there are Oracle-specific modeling extensions, and code engineering features for Oracle
database scripts cover more features), there are two separate transformation flavors as well - “ER to
SQL(Generic)” and “ER to SQL(Oracle)”.

NOTE As of version 17.0.1 the Generic-Oracle DDL(SQL) transformation is no
longer available in MagicDraw. The transformation is no longer needed,
because of unification of previously separate profiles for generic SQL
and Oracle SQL modeling.

Functionality of performing model transformations in MagicDraw is accessible by the Model Transformations
Wizard. The wizard is used for creating new transformations.

To open the Model Transformations Wizard
Do one of the following:

e From the Tools menu, choose Model Transformations.
e Select one or more packages. From the shortcut menu, choose Tools > Transform.

NOTE For more information about this wizard, see “Model Transformation Wizard”
in MagicDraw UserManual.pdf.
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Each transformation has its own default type map for replacing data types from the source domain into the
appropriate data types of the result domain. If this type map is not suitable, the default type map can be
modified or an entirely different type map can be provided if necessary.

NOTE e For more information on how to create your own transformation rules or
change mapping behavior, see “Transformation Type Mapping” in the
MagicDraw UserManual.pdf.

e For more information on how to set up the mapping, watch the
“Transformations” online demo at www.magicdraw.com/viewlets.

There are two very similar UML to DDL transformations:

1. UML to SQL(Generic)
2. UML to SQL(Oracle)

These transformations convert the selected part of a UML model with class diagrams into Generic or Oracle

SQL models with or Oracle SQL diagrams respectively.

Transformation Procedure

UML to SQL(Generic / Oracle) transformation is based on the same copy mechanism as the other
transformations are. It copies the source model part to the destination (unless the in-place transformation is
performed), remaps types, and then performs model reorganization to turn the model into a SQL model.

Conversion of Classes

UML classes from the source model are converted into tables.

Each property of the source class becomes a column in the result table. If a property in the UML model had the
explicit multiplicity specified, nullable=true (for [0..1] multiplicity in source property) and nullable=false (for [1]
multiplicity in source property) marking is applied on result columns.

Operations contained in the source class are not copied into the result table.

Primary Keys Autogeneration

If a UML class in the source model had no primary key (it is declared by applying an appropriate stereotype), an
ID column is generated and marked as the primary key.

The Autogenerated PK name template transformation property governs the name of the generated 1D
column. %t pattern in the name template is expanded to the current table name.

The Autogenerated PK type transformation property determines the type of the ID column. The defaut type is
integer.

Conversion of Associations

One-to-one and one-to-many associations between classes in the source UML model are converted to foreign
key relationships and to foreign key columns in the table, which is at the multiple end.


http://www.magicdraw.com/main.php?ts=navig&cmd_show=1&menu=resources#cdeng
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The Autogenerated FK name template transformation property governs the name of the generated FK
column. A name template can use the following patterns:

e %t is replaced by the name of the table, the foreign key is pointing to.
e %k is replaced by the key name, this foreign key is pointing to.
e %r is replaced by the name of the relationship role, which is realized by this foreign key.

Note that the type of the FK column matches the type of the PK column, to which this key is pointing.

Many-to-Many associations are transformed into the intermediate table. An intermediate table is generated for
an association and has two FK relationships pointing to the tables at association ends. FK are generated in the
same way as for one-to-many associations.

The Autogenerated table name template transformation property governs the name of the generated
intermediate table (%t1 and %t2 are replaced by the names of the tables at relationship ends).

Conversion of Identifying Associations

Some relationships in the source model are treated as identifying relationships. In case of identifying a
relationship, the objects of the class, which is at the multiple end of the association, are not independent, that
is, they can exist only in association with the objects at the singular end of the association. In the resulting SQL
model, the FK of these relationships is included into the PK of the table.

The PK of the dependent table is composite and contains two columns as a result:

1. ID column of the table
2. FK to the independent table

Unfortunately UML models lack model data and notation to specify, which associations are identified. Hence
transformation has to guess this. It uses the following heuristics - the composite associations are treated as
identifying, while the other associations are not.

The Treat composition relationships as identifying transformation property governs these heuristics. If this
property set to false, all associations are treated as not identifying.

Conversion of Multivalued Properties

In UML models, properties can be multi-valued (e.g. [0..7], [2..*]). However in databases columns they can be
only single-valued. Transformation uses two strategies to handle multi-valued properties in the source model.

If the upper multiplicity limit is small and fixed, e.g., [0..3], then columns are simply multiplied the necessary
number of times. The result table will have multiple columns with sequence numbers appended to their names
(like “phone1”, “phone2”, and “phone3” columns in the result for a single phone[0..3] property in the source).

The Max Duplicated Columns transformation property governs the maximum number of columns, that are
generated using this strategy.

If the upper multiplicity upper bound is larger than this limit or unlimited, then an auxiliary value table is
generated for such multi-valued properties. This table is FK-related to the main table of the class, and holds a
“value” column for storing property values.

The Value table name transformation property governs the name of the generated table (%t in this property is
replaced by the name of the table and %r - by the property name). So, the table name template
“%t_%r VALUES” gives a “Person_Phone_ VALUES” table name for the Person::phone property).
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Conversion of Generalizations

In UML, generalizations are used extensively, while SQL domain lacks the concept of generalizations. Hence
during the transformation, generalization trees are transformed into different concepts to simulate the
generalization approximately.

There are three different strategies for simulating generalizations in the result domain:

1. Multiple Tables, Decomposed Object strategy.
2. Multiple Tables, Copy Down strategy.
3. One Table, Merged strategy.

Specify the strategy for converting generalization trees in the Generalization Tree transformation strategy
transformation property.

Multiple Tables, Decomposed Object strategy

This strategy consists of the following actions:

1. Each class is converted to a separate table.

2. Direct (not inherited) properties of the class are converted to the columns of the table.

3. A foreign key to the table of the base class is created. The table of the base class carries the
inherited columns.

4. Primary keys of all the classes participating in a hierarchy tree are the same (there can be
several hierarchy trees in the same transformation source, and each one is handled
separately). PK of the specific tables is also a FK to the parent table.

This strategy is the closest one to UML and fits nicely from theoretical standpoint since there is no data
duplication. The only problem of this approach is the performance of data retrieval and storage. During the
storing operation, objects are decomposed into several parts, each stored in a different table (that is why the
strategy is called Decomposed Object strategy), and for retrieving the object you have to query several tables
(with resulting multi-level joins).

Multiple Tables, Copy Down strategy

This strategy consists of the following actions:

1. Each class is converted to a separate table.

2. The table of each class holds columns for properties of that class AND all the columns, copied
from the base class (that is why this strategy is called Copy Down strategy).

As a result each table possesses the complete column set to carry data about an object of particular type. All
the data of the object is stored in one table.

The weak point of this strategy is that the association relationships between tables are copied down also.
Hence each association in the source can produce many foreign keys in the target. Writing SQL queries against
this database layout is not very convenient. Also, if you want to retrieve all the objects of the particular class,
you have to query several tables and union the results.

One Table, Merged strategy

This strategy consists of the following actions:

1. All the classes in the generalization hierarchy are folded into one large table.

2. All the properties of all the classes become table columns (note that columns that were
mandatory in the specific classes become optional in the merged table).

3. A separate selector column is generated, which indicates the type of the object carried by the
particular line.
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The Selector Column Name, Selector Column Type and Selector Column Type Modifier transformation
properties determine the selector column format.

This strategy is suitable for very small hierarchies usually of just one hierarchy level with a couple of
specialization classes, each adding a small number of properties to the base class. E.g., general class
“VehicleRegistration” and a couple of subclasses: “CarRegistration” and “TruckRegistration”.

This strategy suites simple cases well. It is simple and fast. However it does not scale for larger hierarchies and
produces sparse tables (tables with many null values in the unused columns) in this case.

Conclusions and future improvements

Note that all hierarchies from the transformation source are converted using the same method. You cannot
choose different strategies for each particular case of the generalization tree. This is considered as a future
improvement for the transformations.

Package Hierarchy Reorganization

UML models usually have a moderately deep package nesting organization, while SQL models can have at
most one package level - the schemas. Hence during the transformation, packages should be reorganized.

The Change package hierarchy transformation property governs the package reorganization. Possible
choices for setting the property value are as follows:
1. Leave intact choice switches reorganization off.

2. Flatten packages choice forces flattening of the packages of the source, leaving only the top
level packages in the destination.

3. Strip packages choice removes all packages of the source.

Sequence Autogeneration

NOTE This feature is only available in UML to SQL(Oracle) transformations.
Generic SQL models do not have sequence support yet.

For each single-column PK in the destination a sequence object can be generated.

The Autogenerate Sequences transformation property governs the sequence autogeneration. Possible
choices for setting the property value are as follows:

1. Do not generate sequences choice switches sequence generation off.

2. Generate sequences for all single-column PKs choice switches sequence generation on.

3. Generate sequences for all autogenerated PKs choice switches sequence generation on but
only for those PKs that there automatically generated by the tool (but not for PKs which were
declared by the user).

Type Mapping

Default type maps of the UML to SQL(Generic / Oracle) transformations remap the types that are commonly
used in the UML modeling domain (such as String) into types that are suitable for SQL domain (such as
varchar).

UML to SQL Type Map

The default type map for these transformations is stored in the UML to SQL Type Map profile and
automatically gets attached to your project at the 3rd step (the type mapping step) of the transformation wizard.
If necessary it can be changed.
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The Default map carries the following type conversions.

Source Type Result Type
String varchar (default)
varchar2

char varying
character varying
nvarchar

nvarchar2

nchar varying
national char varying
national character varying
longvarchar

long varchar

char

character

nchar

national char
national character

long char
short smallint
long number(20)
Integer integer
int int
float float
double double precision
date date
char char(default)
character
nchar

national char
national character

byte number(3)

boolean number(1)
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Transformation Properties

This is the complete list of properties available in UML to SQL(Generic / Oracle) transformation in the Model
Transformation Wizard (for more information about this wizard, see “Model Transformation Wizard” in
MagicDraw UserManual.pdf).

EMDdEl Transformation Wizard x|

Transformation Details

{1, Select transformation bype | a) e E"i

{2, Select sourcedestination B General

@ 5. Sl ip e Aukogenerated P name template id_=ik
Autogenerated PK tvpe template inteqer

{+ 4, Specify transformation details autogenerated FE name template %tk
Aukogenerated table name template %ab1_%:E2

Specify transformation details. enerate index For alkernative key ... [ False

Index name template indexof_%%g
Change package hierarchy Flatten packages

Treat camposition relationships asi... W true
Default association end mulkiplicity 1
Generalization Tree transformation ... Mulkiple Tables, Decomposed Object

Selectar Column Marne kypeSeleckor
Selector Column Tvpe char

Selector Column Type Modifier 255

Max Duplicated Columns 3
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exeeds this value - kable is created, otherwise copies are generated.

Reset bo Defaults |

< Back Mexk = Finish Zancel Help |

Figure 33 -- Model Transformation Wizard for UML to SQL(Generic / Oracle) transformation. Specify Transformation
Details wizard step

Property name Description
Autogenerated PK name If the class has no PK column in the ER model, this transformation
template parameter for the autogenerated column name will generate the

PK. You may specify the pattern for the PK name.
Default "id_%t", where %t is replaced by the name of the table.

Autogenerated PK type Specifies the type of the autogenerated PKs.

template Default: integer.

Autogenerated FK name The foreign keys are automatically generated to implement the
template relationships between classes.

This transformation parameter autogenerates a FK name. You may
specify the pattern for the name. Default: "tk_%t%k%r", where %t
is replaced by the name of the table, the foreign key is pointing.
The %k is replaced by the key name, to which this foreign key
points. The %r is replaced by the name of the relationship, which is
realized with this foreign key.
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Property name

Autogenerated table name
template

Generated index for
alternative keys

Index name template

Change package hierarchy

Treat composition
relationship as identifying

Default association end
multiplicity

Generalization Tree
transformation strategy

Selector Column Name

Selector Column Type

Selector Column Type
Modifier

Max Duplicated Columns

Value Table Name

Autogenerate Sequences*

Description

This transformation parameter autogenerates table name. You
may specify the pattern for the name. Default "%t1_%t2", where
%t1 is replaced by the name of the first table, %t2 - second table.
The %r pattern (name of relationship) is also supported.

If “true”, generates index for «AK».

Default: false

If the above option is set to “true”, you may choose the template for

the index name. Template may contain %g pattern, which will be
replaced with AK group name.

Default: indexof_%g
Choose option for packages from transformation source: to strip all

the package hierarchy, or flatten the package hierarchy down to the
first level where each package is transformed into the schema.

Default: Flatten packages

If this option is set to “true”, the composition associations are
treated as if the «identifying» stereotype were applied to them.
Default: true

If multiplicity was not specified in model, defined multiplicity will be
set after transformation.

Default: 1

Selects the strategy to be used for converting generalization trees.
Default: Multiple Values, Decomposed Object

Name of selector column for the merged table strategy of
generalization conversion

Default: typeSelector

Note: together with selector type and type modifier this gives
typeSelector:char(255) column.

Type of the selector column for the merged table strategy of
generalization conversion.

Default: char

Type modifier of the selector column for the merged table strategy
of generalization conversion

Default: 255

Threshold for multivalue property conversion strategies - maximum

number of columns for which the column duplication strategy is
used. If exceeded, auxiliary value table is used.

Default:3
Name of the value table (to be generated when converting

multivalue properties). %t pattern is expanded to table name, %r -
name of the original property.

Default: %t_%r VALUES

(e.g Person_phone_VALUES table will be generated for
Person::phone[0..5] property in the source)

Selects wherever and when sequences are generated for PKs
Default: Generate sequences for all single-column PKs
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Property name Description

Autogenerated Sequence Name of the generated sequences. %t pattern is expanded to table
Name* name.

Default: %t_SEQ

* - These properties are available only for UML to SQL(Oracle) transformation.

Both generic and Oracle transformation flavors are very similar, so they will be described together.
Furthermore, these transformations are based on and very similar to the UML to SQL(Generic / Oracle)
transformations with several extensions, relevant to ER modeling.

Hence this chapter only describes this extended behavior of ER to SQL(Generic / Oracle) transformation. To
see the full transformation feature set (which includes conversion of many-to-many relationships into an
intermediate table, three different methods of transforming generalizations into table layouts, autogenerating
primary keys, unique constraints and indexes, generating additional tables for multivalue attributes, type
remapping between UML and database worlds, sequence generation, and package hierarchy flattening),
please, see “UML to SQL Transformation” on page 61.

NOTE Please note that the SQL model, produced by the transformation, is usually not
optimal (e.g. all the generalizations are transformed using the same chosen
strategy, while usually different strategies are chosen for each particular case -
at the discretion of DBA). Hence it is frequently advisable to refine / edit the pro-
duced model after the transformation.

Identifying Relationships

Identifying relationships are transformed in the same way as in the UML to SQL transformation, that is, the
foreign key of the transformation gets to be included into the primary key of the dependent entity (the one at the
multiple end of the relationship). The difference in ER to SQL transformation case is that the ER model
eliminates guessing, which relationships are identifying and which ones are not. UML to SQL transformation
guesses, which UML associations should be identifying, by using a heuristic method - composition associations
are treated as identifying (this heuristic is controlled by the Treat compositions as identifying transformation
property). In ER models, identifying relationships are explicitly marked as such, hence there is no need to
guess (“Identifying Relationships and Dependent Entities” on page 9 specifies how identifying relationships are
modeled).

Key Transformation

Keys in ER models are transformed into constraints in a DDL model.

These are the rules for key transformations into DDL constraints:
1. The Primary key of the entity in the ER model is transformed into a primary key constraint in the
SQL model.

2. The Alternative keys of the entities in the ER model are transformed into unique constraints in
the SQL model.

3. The Inversion entries of the entities in the ER model are transformed into indexes in the SQL
model.
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4. If key or entry in ER model has a name (identifier tag), this information is preserved in the SQL
model. The corresponding key / index will also have a name in the SQL model.

Lets review an example of key modeling, which has been described in “Key Modeling” on page 14. After the
transformation, the three entities of the ER model are transformed into the three tables of the SQL model
respectively.

ztables
Person

«Fl=-58nN  varchar
-name :varchar
-surname :varchar

zUNigUe=+{columns = name, surname}

ztables
ShippingAddress
=Ple-id  integer
-country  varchar
-city cvarchar
-street : varchar
-nr:varchar

-postalCode ; varchar

zUnique=+addr{columns = country, city, street, .
zUnigue=+postd{columns = country, postalCode}

ztables
InventoryPartType

«FPH=-code :varchar
-name :varchar

zindex=+indexof_{ name)

Figure 34 -- Example of key transformation results

Virtual Entity Transformation

Virtual entities of ER models can be transformed into different elements of SQL models:
e Tables (just as ordinary, non-virtual entities).

e SQL views (ER to SQL(Oracle) transformation has an additional choice of simple views or
materialized views).

The choice is controlled by the Virtual Entities Transformed To transformation property.

Tracing between Data Model Layers

After the transformation, a relationship is established between the logical data model layer, which is
represented by the ER model, and the physical data model layer, which is represented by a SQL model
respectively. It is possible to navigate between the connected elements in the forward (ER -> SQL) and
backward (SQL -> ER) directions using the dedicated submenu - Go To - on the element’s shortcut menu.

To go to the corresponding element in the forward direction

1. Right-click the element.
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2. On it’s shortcut menu, click Go To > Traceability > Model Transformations > Transformed
To.

To go to the corresponding element in the backward direction

1. Right-click the element.

2. On it’s shortcut menu, click Go To > Traceability > Model Transformations > Transformed
From.

The same tracing information is visible in the element’s Specification window and Properties panel under the
Traceability tab. This information is also reflected in the Entity-Relationship and SQL Report using navigable

references between the report section. Traceability information can also be depicted in a relation map or in a
tabular format using the capabilities of the custom dependency matrix feature.

The SQL models and diagrams will be transformed into the platform-independent UML models and UML class
diagrams. SQL to UML transformation can be applied to SQL models of any database flavor.

Type Mapping

If there are types specified in the SQL model for elements, after transformation SQL types should be converted
to UML types. Because of that, there is a type mapping from SQL types to UML types.

Mapping rules are based on dependencies, which contains the SQL to UML Type Map profile. This profile is
automatically attached, when SQL to UML transformation is performed.

Transformation Results

The SQL stereotypes are discarded from tables, views, fields, and associations (except the PK stereotype).

Views are discarded in transformed class diagram.
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There are additional properties to choose for SQL to UML transformation in the Model Transformation Wizard
(for more information about the wizard, see “Model Transformations Wizard” in MagicDraw UserManual.pdf.)

EMDdEl Transformation Wizard x|
Transformation Details
" 1. select transformation type B AL E BE B
{~ 2. select source,/destination EH General
Ise PK [+ true
" 3.5elect t i
SRR BTSRRI Ise IE [ false
{* 4. Specify transformation details Use AK [ false
Specify transformation details.
(Mame)
(Descripkion)
Resel ko Defaults |
< Back Mexk = Cancel Help |

Figure 35 -- Model Transformation Wizard for SQL to UML transformation. Specify Transformation Details wizard step

Option name Type Description

Use PK Check box If set to “true”, appropriate columns with the primary key
stereotype are marked after transformation.

Use IE Check box If set to “true”, indexed columns with the inverted entity
stereotype are marked after transformation.

Use AK Check Box If set to “true”, unique columns with the alternative key
stereotype are marked after transformation.

The «IE» stereotype is applied to the columns in the UML model from indexes in the SQL.
The «AK» stereotypes are applied to the columns in the UML model from unique constraints in the SQL.

If the unique or index of the SQL contains more than one column, the group tag is created on the
corresponding columns. The value of the tag is the name of the unique / index.

If the PK, unique constraint or index of the SQL contains more than one column, the orderinXXGroup tag is
created on the corresponding columns. The value of the tag is the place number of the column in the PK,
unique constraint or index (first column gets tag value=1, second column - 2, etc).

Before transformation:

==table==
Person

-1D
-Mame
-Bank account

==ynigue==+saland D, Mame)
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After transformation:

Person

=== Dgroupak = salary, orderlnAKGrougp =1}
==&k =-Mameigroupsl = salary, orderlnAKGroup = 2}
-Bank account

There are some foreign key cases, when after transformation, association with multiplicities are created in class
diagram:

Transforming foreign key, when the «unique» stereotype is set

Before transformation:

==tahle==
=<table==

Person
Account
=zPK=>-1D R s e _
-Mame FK columns = Account | % ¥Unique==-Number

; -Currenc
==Unigue==-Account Pk columns = Number) v

After transformation:

Person Account
-l 0.1 0.1 [-Mumber
-Marme -CUrrency

Transforming foreign key, when the «not null» stereotype is set

Before transformation:

=<tahle==
==table==

Person
a=Flmn Account
ST ETE | e g S —
-Mame {FK columns = Account, | S =4nique==-Numher

==not null==-Account| Pk columns = Mumber} ey

After transformation:

Person Account

- 0.* 1 -tumber
-Mame -Currency
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Transforming foreign key, when the «null» stereotype is set

Before transformation:

=<tahblg=» T
Person NGOl
sl —— — — — - Z|==unigue==-Number
Ll ==Fl=> -CUrFERCY
==null==-Account| {FK columns= Azcount,
PK columns= Number}

After transformation:
Person Account
0.x 0.4
- -Mumber
-Matme -CUFrency

Transforming foreign key, when the «unique» and the «not null» stereotypes are set

Before transformation:

==tahle== T
Person ACCOLHE
sERemll Z|==unigue==-Number
-Mame =z=Fl== -Currency
==not null== ==unigue==-Account | {FK columns = Account,
PK columns= Number}

After transformation:

Person Account
0.1 1

- -Mutnber

-Matne -Currency

The UML to XML Schema transformation helps to create the equivalent XML schema model from the given
UML model.

Basically this transformation is the copying of a source UML model, and then applying the necessary
stereotypes according to the XML schema modeling rules.
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Type Mapping

This type map stores mapping between primitive UML data types and primitive XML Schema data types.

zdataTypes lemap: [eXS0DsimpleTypes
«XSDsimpleTypes: [ | «XSDsimpleTypes «XSDsimpleTypes boolean boolean
integer unsignedint positivelnteger {id="hoolean"}
fid ="integer} | {id="unsignedint"} | [id="positivelntzger"}
i3 n G
b1 / <
\ «M3ps p zX50simpleTypes zflataTypes _«m_ap»% zXs0simpleTypes
\=map= =maps . nonNegativelnteger byte hyte
[default} \ - lid="nonMegativelnteger'} {id ="hyte"}
! i . =
Y / amaps .
oy - - =AS0simpleType=
- .
cprimitives | 2P 5} ~monPositivelnteger <dataTypes Jemaps [«XSDsimpleTypes
Integer | lid="nonPositivelnteger'} Bhart L — short
— ~ e fid="short'}
L ™ = .
/ A ™ emaph =X50simpleTypes
; = negativelnteger
«maps «maps h ~ fid="negativelnteger'} _
! 1y = zllataTypes [emaps |«XS0simpleTypes
! \ = — int it
/ \ a:{SD_mmpleType» {id ="int"}
unsignedLong
/ \ flid="unsignedLong"}
e ]
eXS0simpleTypes «XS0simpleTypes -
unsignedByte unsignedShort zdataType= [=maps =XS0simpleTypes
fid = "unsignedBtype"} | [id ="unsignedShort'} long long
{id="long"}
eXSDsimpleTypes eXS0simpleTypes= zdataTypes= zdataTypes [emap: [«XS0simpleTypes
baseG4Binary hexBinary char float | float
lid="base64Binan} {id ="hexBinar/"} | fid ="float"}
i3 il |
A /
W oeMaps= ! l
\ 4 emapz amaph edataTypes |emap= |«XS0simplaTypes
v I double N double
. s {id="douhle"}
zprimitive s B emaps eXS0simpleTypes
String | {_def;ult}_ — = string
/ N, - fid="string"}
«Maps , wemaps™ __e«maps
s , = -
2 3y e
«XS0DsimpleTypes= exS0simpleTypes= exXS0simplaTypes
anyURI QOName decimal
{id="anyURI"} {id="0QMame"} fid="decimal"}

Figure 36 -- UML to XML schema type map (1)
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«XS0simpleTypes= «XSDsimpleType=
duration date
{id ="duration"} {id="date"}
il Eal
-~
! -~
«Maps /  eMaps “
/ - «X50simpleTypes
J P ) dateTime
;- «Maps _ — | Jid="dateTime"}
«XS50simpleTypes emaps zdataTypes= |— — “{default}
gDay S date —
fid ="gDay’) N
«maps - ! \ ™ - = «¥S0simpleTypes
P / A A - time
P -~ eMaps ; ,\‘Kmap» m«r\nap» fid = "time"}
aXS0simpleTypes ! % -
gMonthDay / 1 -
{id = "gMonthDay"} " y o
«X50simpleTypes «X30simpleTypes «X50simpleTypes
gMonth gearMonth gYear
{id ="gMonth"} {id="gYearMonth"} fid="gYear"}

Figure 37 -- UML to XML schema type map (2)

Transformation Results

For each class in the transformation destination set, the «XSDcomplexType» stereotype is applied, unless this
class is derived from the simple XML type (that is, one of the basic types, or type, stereotyped with
XSDsimpleType). In that case a «XSDsimpleType» stereotype is applied.

If the class is derived from another class, which is stereotyped as «XSDcomplexType», additionally the
«XSDcomplexContent» stereotype is applied on this class with «XSDextension» on the corresponding
generalization relationship.

If the class is derived from another class, which is stereotyped as «XSDsimpleType», additionally the
«XSDrestriction» stereotype is applied on the corresponding generalization relationship.

If the class is not derived from anything, and has attributes with the XSDelement tag, the
«XSDcomplexContent» stereotype is applied on this class.

If the class is not derived from anything, and has no attributes with the XSDelement tag, no «XXXXContent»
stereotype is applied on this class - the class has an empty content.

The UML datatypes in the transformation source set are transformed into the classes with the
«XSDsimpleType» stereotype - unless after the type map this class appears to be derived from a class with the
«XSDcomplexType» stereotype. Then the «XSDcomplexType» stereotype is used.

For each attribute of the class, which is NOT of the simple XML type (that is, one of the basic types, or type,
stereotyped with the «XSDsimpleType») or has a multiplicity > 1, the «XSDelement» stereotype is applied.

For each composition association, linking 2 classes stereotyped as XML schema types, the stereotype on the
association end is applied, the same as the rules for attributes.
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Enumerations in the UML model are transformed into the enumerations in the XML Schema model (classes
with the «XSDsimpleType» stereotype are derived by restriction from the XML string type, where all the
elements of the original enumeration are converted into the attributes with an «XSDenumeration» stereotype).

For each package in the transformation set, the «kXXSDnamespace» stereotype is applied.

In each package, one additional class for the XML schema is created. The name of the schema class is
constructed by taking the name of the package and then appending the .xsd to it (e.g. if the package in the
source model set is named "user”, then name the schema class "user.xsd" in the destination package).

The targetNamespace value is added to the schema class, with the name of it's parent (e.g. if the schema is
placed in the "http://magicdraw.com/User" package, the targetNamespace=" http://magicdraw.com/User" is set
on the schema class).

Schema class and the namespaces http://www.w3c.org/2001/XMLSchema [ XML Schema profile] and its target
namespace are linked using the xmins relationships. The names of these links are: the same as target
namespace, for the link to target namespace; "xs" for the XML Schema namespace.

Class diagrams are transformed into XML Schema diagrams.

The model elements, which have no meaning in the XML schemas, are discarded. This includes (without
limitation) behavioral features of classes, interfaces, actors, use cases, states, activities, objects, messages,
stereotypes and tag definitions.

There are additional properties to choose for UML to XML Schema transformation in the
ModelTransformation Wizard (for more information about the wizard, see “Model Transformations” in
MagicDraw UserManual.pdf.)

EMudEI Transformation Wizard x|
Transformation Details
1. select transformation type B B = BE B
(" 2.Select source/destination Bl oeneral |
3 Select b ) Default Compositor #3Dall
AEas s Sl LS Default Attribute Kind wSDelement
{+ 4. Specify transformation details
Specify transformation details.
General
Resef ko Defaults |
< Back =3 e Finish Zancel Help |

Figure 38 -- Model Transformation Wizard for UML to XML Schema transformation. Specify Transformation Details
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Option name Type Description
Default Combo box Possible choices: XSDall, XSDchoice, XSDsequence
Compositor Determines element grouping in complex types of XML
Schema.
Default: XSDall
Default Attribute | Combo box Determines to what attribute kind, XSDelement or
Kind XSDattribute UML attribute will be mapped.

Default: XSDelement

The XML Schema to UML transformation helps to extract the abstract UML model from the XML schema
model.

Type Mapping
Type maps store mapping between primitive UML data types and primitive XML Schema data types, the same

applies for UML to XML Schema Transformation just in reversed order. For XML Schema to UML element type
mapping diagram, see “Type Mapping” on page 74.

Transformation Results

The XML Schema diagrams are transformed to the Class diagrams.
Unnecessary stereotypes (XSDxxxx) are discarded from the classes.
Attributes of the classes are gathered if they were spread into several different classes.

Attributes of the classes may be realized as associations. In this case the main class gathers all the
associations of the members.

The same principle is applied when elements are in a group, shared by two or more classes. Elements
(attributes) are copied into both destination classes.

The attributes with the «XSDgroupRef» stereotype are treated as if the group relationship has been drawn and
transformed accordingly - discarded in the UML model, and the group content (elements / attributes) placed in
their place.

Simple XML schema types (classes with the «XSDsimpleType» stereotype), which after copying and type
remap happen to be derived from any data type (UML DataType) or not derived from anything and are
transformed into the UML data types.

Simple XML schema types, which are derived by restriction from string and are restricted by enumerating string
values and are converted into enumerations in the UML diagrams.

The classes with the «xXSDschema» stereotype are not copied into a destination model.

The «XDSkey», «XSDkeyref», and «XSDunique» stereotyped attributes are not copied into a destination
model.
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The «XDSany», «XSDanyAttribute» stereotyped attributes are not copied into a destination model.
The «XDSnotation» stereotyped attributes are not copied into a destination model.

The «XDSlength», «kXDSminLength», «XDSmaxLength», «XSDpattern», «XSDfractionDigits»,
«XSDtotalDigits», «XDSmaxExclusive», «XDSmaxInclusive», «XDSminExclusive», and «XDSminInclusive»
stereotyped attributes are not copied into a destination model.

The XML schemas (classes with the «XSDschema» stereotype) should not be transformed, but they may
contain inner classes (anonymous types of schema elements). These inner classes are transformed using
usual rules for UML type transformation - as if they were not inner classes but normal XML schema types.



ENTITY-RELATIONSHIP AND
SQL REPORT

MagicDraw provides a report template for generating reports of the data models. The report template is
suitable for reporting both ER and SQL models. If your project contains both ER and SQL models, a unified
report covering both models can be produced.

The report can be generated using the Report Wizard feature.

To generate a report

1. On the Tools menu, click Report Wizard.

2. In the Select Template area, select Data Modeling > Entity-Relationship and DDL Report
and then click Next >.

3. Click Next > again.

NOTE In this step, you can edit report variables. To start editing
variables, click the Variable button.

4. In the Select Element Scope area, define the scope for the report, using the buttons placed
between the two lists, and then click Next >.

5. In the Output Options area, define the appropriate options.

6. Click Generate. Wait a moment while the report is generated (generation time depends on the
selected scope).

The Report Wizard produces an .rif file. This file contains sections for each reported model entity, its attributes,
relationships with other entities (both simple relationships and generalization / specialization relationships), and
keys. The SQL part of the file contains sections for each table (with its columns, constraints, indexes, and
triggers), each standalone sequence, each global procedure or function, each user defined type (with its
attributes and methods), and each authorization identifier (users, groups, roles, and permissions).

The report has a boilerplate beginning and includes a cover page, table of contents, and a table of figures.
Sections such as “Purpose”, “Scope”, “Overview”, and “Revision History” can be customized by changing the
predefined report variables (see the 3rd step of the report generation procedure, described above). The report

also has an appendix containing all the diagrams in your model.



If the model contains both ER and SQL models and is linked by traceability references, the report will link (with
active references) the appropriate report sections of entities and tables that are traceable in the model.

Entity-Relationship Modding ER&SHL Report
Date: Mardch 26, 2010 Revison: 1.0

Entity Purchase
Transformed To: Furchase

Attributes:

=  PONnSring

=  guantity:Integer

=  pricedithDiscount: Integer

=  totsl:Integer

= yeanInteger

= month:Month

=  day:Integer
Keys:

#  Primary {ancmymousk PONr
Relstionships:

=  many|optional}-toone{ mandatony) Salesman (as NAR MHentifying NA
= manyloptional}-oone{ mandatory) Product (as NA): Idantifiiing MA

e T T T

T

Confidential = Wour Company Name:= 12

Figure 39 -- Fragment of ER model report example
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Entity-Relationship Modeing ER&SOL Report
Date: March 26, 2010 Revision: 1.0

Table Virtual_Entities.Purchase
Transformed From: Purchass

Columns:

*  POMNnvarchar

=  guantibyinteger

+  price®ithDiscount:integer

*  total:integer

=  yeaninteger

«  month:Month

s+ dayinteger

»  fk_Salesmanid:varchar MOT NULL

= fk_Productidsvarchar MOT MULL
KeysfConstraints/Indesxes Triggers:

& Primany [znomymousl PONr, fi_Salesmanid, fl_Productid

#  Foreign {anomymous): b table Salesman, fk_Salesmanid=Szlesman.id

#  Foreign {anomymous)(1k to table Product, fk_Productid=Product.id

*  gayunisger
#  fk_Salesmanid:varchar NOT NULL
& fk_Productidsvarchar NOT NULL
Keys/Constraints/Indees Triggers:
#*  Primany (anomymousk PONr, fk_Salesmanid, flk_Productid
# Foreign {anomymous): B table Salesman, fk_Salesmanid=Salesman.id
&  Foreign {anomymous)(1k to table Product, f_Productid=Product.id

e T T T

Fﬂfﬁ

1

Confidential < Your Company Name=

Figure 40 -- Fragment of SQL model report example
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XML SCHEMAS

Introduction

Reference: http://www.w3.org/TR/xmIschema-2/

82
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Defined stereotypes

Stereotype name

XSDcomponent

XSDattribute

XSDelement

XSDcomplexType

XSDsimpleConte
nt

XSDcomplexCont
ent

XSDgroup

Base
Stereotype

XSDcomponent

XSDcomponent

XSDcomponent

XSDcomponent

Applies on

Class

Attribute
AssociationEnd
Binding
Generalization
Comment
Component
Attribute

Attribute
AssociationEnd

Class

Class

Class

Class

Defined TagDefinitions

id — string

Details: The base and abstract stereotype for all
XML Schema stereotypes used in UML profile

fixed — some fixed element value
form — (qualified | unqualified)

refString — string representation of reference to
other attribute.

ref — actual reference to other attribute

use — (optional | prohibited | required) : optional
abstract — (true | false)

block - (extension | restriction | substitution)
final - (extension | restriction)

fixed — some fixed element value

form - (qualified | unqualified)

nillable — (true | false)

refString — string representation of reference to
other attribute.

ref — actual reference to other attribute

substitutionGroup — actual reference to UML
ModelElement

substitutionGroupString — string representation
of substitution group

key_unique_keyRef — a list of referenced UML
Attributes

sequenceOrder — a number in sequence order
block — (extension | restriction)

final — (extension | restriction)

mixed — (true | false)

simpleContentld — string

complexContentld — string

complexContentMixed
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Stereotype name

XSDgroupRef

XSDall

XSDchoice

XSDsequence

XSDrestriction

XSDextension

XSDattributeGrou

p

XSDsimpleType

XSDlist
XSDunion

XSDannotation

XSDany

XSDanyAttribute

XSDschema

Base
Stereotype

XSDcomponent

XSDcomponent
XSDcomponent

XSDcomponent

XSDcomponent

XSDcomponent
XSDcomponent

XSDcomponent

XSDcomponent

XSDcomponent

XSDcomponent

Applies on

Attribute
AssociationEnd
Class

Class

Class

Generalization
Generalization

Class

Class

Class
Class

Comment

Attribute

Attribute

Class

Defined TagDefinitions

sequenceOrder — a number in sequence order

allld — string

maxQOccurs

minOccurs

choiceld - string

maxQOccurs

minOccurs

sequenceOrder — a number in sequence order
sequenceld — string

maxOccurs

minOccurs

sequenceOrder — a number in sequence order

final - (#all | (list | union | restriction))

listld - string
unionld - string

applnfoSource
applnfoContent
source

xml:lang
namespace — string

processContents - (lax | skip | strict);
default strict

sequenceOrder — a number in sequence order
namespace — string

processContents - (lax | skip | strict);
default strict

attributeFormDefault
blockDefault
elementFormDefault
finalDefault

targetNamespace — reference to some
ModelPackage

version

xml:lang
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name — to UML Attribute or AssociationEnd name.

Stereotype name Base Applies on Defined TagDefinitions
Stereotype
XSDnotation XSDcomponent | Attribute public
system
XSDredefine XSDcomponent  Class
XSDimport XSDcomponent Permision schemalocation
«import»
XSDinclude XSDcomponent Component
XSDminExclusive XSDcomponent Attribute fixed = boolean : false
XSDminlnclusive XSDcomponent Attribute fixed = boolean : false
XSDmaxExclusiv ' XSDcomponent Attribute fixed = boolean : false
e
XSDmaxInclusive XSDcomponent Attribute fixed = boolean : false
XSDtotalDigits XSDcomponent  Attribute fixed = boolean : false
XSDfractionDigits XSDcomponent Attribute fixed = boolean : false
XSDlength XSDcomponent  Attribute fixed = boolean : false
XSDminLength XSDcomponent  Attribute fixed = boolean : false
XSDmaxLength XSDcomponent Attribute fixed = boolean : false
XSDwhiteSpace = XSDcomponent Attribute fixed = boolean : false
value
XSDpattern XSDcomponent  Attribute
XSDenumeration XSDcomponent Attribute
XSDunique Attribute selector
field
XSDkey Attribute selector
field
XSDkeyref Attribute selector
field
refer — UML Attribute
referString - String
XSDnamespace ModelPackage
xmins Permission
attribute

XML schema attribute maps to UML Attribute with stereotype XSDattribute.
default maps to initial UML Attribute or AssociationEnd value.
annotation — to UML Attribute or AssociationEnd documentation.

type or content simpleType — to UML Attribute or AssociationEnd type.
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Other attributes or elements maps to corresponding tagged values.

<attribute
default = string
fixed = string

form = (qualified | unqualified )
id = ID
name = NCName
ref = QName
type = QOName
use = (optional | prohibited | required )4:4optional
{any attributes with non-schema namespace . . .} >
Content: (annotatior?, (simpleType?))

</attributes>

Example:

<xs:attribute name="age" type="xs:positivelnteger" use="required"/>

ref value is generated from ref or refString TaggedValue.

One of ref or name must be present, but not both.

If ref is present, then all of <simpleType>, form and type must be absent.

type and <simpleType> must not both be present.

attribute UML Model example:

==x50schema==
schema.xsd
{targethamespace=hitpihomagic.com}t

s=xE0attrbute>>surname : string

s=xs0attnbute==-address . annomynous{fixzed=fixed value, form=gualified, use=optional -
s<xs0atinbute==name : string = mindeffixed=hxed_value, form=gualified, use=optional}

&4

<<HE0simpleType==
ahnomymous

=<HEDattribute Group==
attr_group

==x=Dattribute=>-fref=name}
==x=Dattnbute=>-Jref=surname}
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<xs:schema xmlIns:nm = "http://nomagic.com" xmins:xs = "http://www.w3.0rg/2001/XMLSchema"
targetNamespace = "http://nomagic.com”

«xg:attribute name = "name® type = "xg:string® default = "minde®
fixed = "fixed wvalue' form = "gualified" use = "optional® -
sxg:annotation =
cxg:documentation -name attribute
documentation=</xs:documentations=
=/xsrannotation=
< /xgattributes
«xg:attribute name = "addregg" fiwed = "fiwed value" form =
"qualified" use = "optiocnal" =
cxg:annctation =
«xg:documentation =surname attribute
documentations,/xg:documentations
«/xsrannotations
=xg:simpleType -
«xg:restriction base = "xs:string" /-
=fxg:gimpleTypes
</xgattribute:

<xg:attribute name = "surname" type = "xs:string® /-
«xg:rattributeSroup name = "attr group” -
=¥gzattribute ref = "nm:name” =

=¥g:annotation =
z¥g:documentation sreference
documentation<,/xg:documentation=
< /¥8:annotations
=fxgrattributes
cxs:attribute ref = "nm:surname” /=
</xg:attributeGroup=
= /xg: schemax>

element

Maps to UML Attribute or UML AssociationEnd with stereotype XSDelement.
e annotation — to UML Attribute or UML AssociationEnd documentation.
e default - to initial UML Attribute or UML AssociationEnd value.
e maxOccurs - to multiplicity upper range. Value unbounded maps to asterisk in UML.
e minOccurs — to multiplicity lower range.
e name — to UML Attribute or UML AssociationEnd name.
e type or content (simpleType | complexType) — to UML Attribute or UML AssociationEnd type.

Other properties maps to corresponding tagged values.
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XML Representation Summary: element Element Information Item

zelement
abgtract = bhoglesn : false
block = (#all | List of (extenmsion | restriction | substitution))
default = ghripg
final = (#all | List of {(extension | restriction))
fixed = gtring
form = (gualified | ungualified)
id = ID
maxDoours = (pooNegativelpteger | unbounded) =1
minOcours = poplegativelpteger @ 1

nama = NCName

nillable = pogpleap : false

ref = QHame

substitutionGroup = OName

type = QName

fany attributes with non-schema namespace . . .}=

Contept: (anpotation?, ((zimpleTvpe | complexTvpel?, (unigue | key | kevr

< /element -

ref value is generated from ref or refString TaggedValue.

One of ref or name must be present, but not both.

If ref is present, then all of <complexType>, <simpleType>, <key>, <keyref>, <unique>, nillable, default, fixed,
form, block and type must be absent, i.e. only minOccurs, maxOccurs, id are allowed in addition to ref, along
with <annotation>

88
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Example:

<xs:element name="PurchaseOrder" type="PurchaseOrderType"/>

<xs:element name="gift"s>

<xs:complexType>
<XS:sequence>
<xs:element name="birthday" type="xs:date"/>
<xs:element ref="PurchaseOrder"/>

</xs:complexType>
</xs:element>

element UML Model example:

e RS Dechamasns
=oharna

| tar g= fame =p apes htp Mnomagic
urmln e nm =k kp:dd om agic.

O e
= wnSCHe me rkr > -count @ coun tType
= 24 S0ele menkx » -hour : integer
= ¥ S0ale mants» -minuta : inkeger{subs iutionGroup Sieing = nmecoant

< «WES0ele mert-s-name: shing = mindelblak=exknszion nillable. absrad final zre stricion. faem=aqualifed. soubsinbonGroo p=count Bed= Aredalue, id=element

1

< MED=zimple Typer -
o T iys

L

rumber

i S Doomple aTypesr ¢
<4 EDall»

Zarne_fype

-houiRef [0.1]
-minuteRe[0.1]

1.0

== UrN aMm

Fi]

<¢ ¥E50element::

string
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<xg:gchema xmlns:nm = "http://nomagic.com” xmlng:xs =

"http: //www. w3 org/2001/¥MLSchema™ targetMNamespace = "http://nomagic.com" =
<x5:element name = "name" type = "xs:string® default = "minde" id = "elementID"

abstract = "true" block = "extension" final = "restriction" fixed = "fixedValue" form =

"gqualified" nillable = "true" substituticnGroup = "nm:count" =

exg:annotation >
zxg:documentation =element name documentations/xs:documentations
< /xg:annotations
</%g:element >
<¥s:element name = "count® =
exg:annotation >
zxg:documentation =element count documenations/xs:documentations
< /xg:annotations
<xg:simpleType =
<xg:restriction base = "xg:number® /=
=/xs:simpleType=
= /xz:element =

=xg:element name = "hour" type = "xs:integer" />
<xg:element name = "minute® type = "xg:integer” substitutionGroup = "nm:count® /-
<xgs:elenent name = "surname® type = "xs:string" minfccurs = "1" maxOccurs =
"unbounded" /=
«xs:complexType name = “"some type™ =
«=¥5:all =
<xg:element ref = "nm:hour® minCccurs = "0% maxOccurg = "1 =

zxgrannctation =
=xg:documentation =hour ref
documentatuions=/xs:documentations
</xg:annotation=
z/xgrelement »
cxg:element ref = "nm:minute" minQOccurs = "0" maxQccurs = "1" [

c/wg:alls
< /%s: complexType:

complexType

Complex type maps to UML Class with stereotype XSDcomplexType.
e abstract - to UML Class abstract value(true | false).
annotation - to UML Class documentation.
attribute — to inner UML Class Attribute or UML Association End.
attributeGroup — to UML AssociationEnd or UML Attribute with type XSDattributeGroup.

name — to UML Class name.

This class also can have stereotypes XSDsimpleContent, XSDcomplexContent, XSDall, XSDchoice,
XSDsequence.

No stereotype — the same as “XSDsequence”.

Generalization between complex type and other type has stereotype XSDrestriction or XSDextension. We
assume stereotype XSDextension if generalization do not have stereotype.

Some complex mapping:

e complexType with simpleContent — to UML Class. This class must be derived from other class
and can must have stereotype XSDsimpleContent.

e complexType with complexContent — to UML Class. This class must be derived from other
class and must have stereotype XSDcomplexContent.
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complexType with group, all, choice or sequence — to UML class with appropriate stereotype.

zcomplexType

abstract = boolean : false

block = (#all | List of (extension | restriction))

final = (#all | List of (extension | restriction})

id = ID

mixed = boglesp : false

name = NCHName

{fany arcributes with non-schema namespace . . .J}»

Content: {apmotation?, (simpleContent | complexContent | ((gxoup | al
{lattribute | attributeGroup)*, anvAttribute?)))|}

=/ complexTypes

When the <simpleContent> alternative is chosen, the following elements are relevant, and the remaining
property mappings are as below. Note that either <restriction> or <extension> must be chosen as the content of
<simpleContent>

<gimpleContent
id = ID
fany attributes with non-schema namespace . . .J}=
Content: (annotation?, (restriction extension) )

</simpleContent>
zregbtriction
bage = Name

id = IO
{any attributes with non-schema namespace . . . }=
Content: (annotation?, (simpleType?, (minExclusive | minlnclusive | maxE:
maxInclusive | totalligits | fractionDigits | lenath | minlength | maxLeng

whiteSpace | pattegn}*)?, {({attribute | attributeGroup)*, anyAttribute?))
< /regtriction>
zgxtensicon

base = QName

id = 1D

{fany acrributes with non-schema namespace . . .=

Content: {annctaticn?, (lattribute | attributeGroun) *, anyvhittribute?))
<z /extension>

zattributeliroup
id = ID
ref = OName
{any attributes with non-schema namespace . . . }=
Content: (gopnotaticn?)
z/attributeiroup=
canyhttribute

When the <complexContent> alternative is chosen, the following elements are relevant (as are the
<attributeGroup> and <anyAttribute> elements, not repeated here), and the additional property mappings are
as below. Note that either <restriction> or <extension> must be chosen as the content of <complexContent>,
but their content models are different in this case from the case above when they occur as children of
<simpleContent>.

The property mappings below are also used in the case where the third alternative (neither <simpleContent>
nor <complexContent>) is chosen. This case is understood as shorthand for complex content restricting the ur-
type definition, and the details of the mappings should be modified as necessary.
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zcomplexContent
id = ID
mixed = hoolean
{any actributes with non-schema namespace . . .}=
Content: (anpotation?, (restriction | sxtensicn))
= focomplexContent »
<restriction
base = OName
id = ID
{any attributes with non-schema namespace . . .}=
Content: (agnotaticon?, (group | all | ghoice | seguencge)?, ((attxibute |
artributeGroup) *, anyAttribute?))

< /restriction=
zextension
base = (QName
id = ID
{any actributes with non-schema namespace . . .}=
Content: (annotation?, ({group | all | choice | geguence)?, ((attribute
attributedroup) *, anvattribute?)))
= /extensions=
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complexType UML Model example:

==HZD=zchama»==
schema
ftargethl am e space=htp homagic.com

A lnenm =http :fnomagiccom }

==H5D com ple=Typo=x
my_Tyipe
{final=extension,
hlack=exden=zion,

" T"" i“‘IE'D“- <= K50 stttk Ute Groups
=myTpellhe attr_group
=M= altribute==name : =tring
=+ M50 anyttribute==-unnam edi
== k30 regftriction==
A=HE50 com plaxType==
==HIDcomplextontent==~ 22 %S0 com plexTyess
my_Type2 ==KS Dcom plext ontent==
ffinal=eden zion ==H5Dall==
block=axten zion, my_Type3
m iz, -
Com plexs o nlenthiixed= false | ==MEDelem ent==_order! : aFrlng
com plex ontentid=conie ntlD } - <=HSDelem ent—--order: sting
string
==HISD attribute==-surnam ¢ : =king

= =Rk =Drestriction==

=aWSDCcom plexType ==
== {50 =simpleconte ni==

my_Types

=< RIDcom plexTypes==
=z 850 =imple Cantents=

my_Typed

==HEDatiribute ==-atlr : siring

<=2=0m inLength==-mninLengi = 2

=Pxml wversgion='1l.0' encodings='Cpl2&2'7%=

<xg:gchema xmlns:nm = "http://nomagic.com® xmlng:xs

"http: //www. w3 _ org/2001/XMLSchema" targetNamespace = "http://nomagic.com" =
=g :complexType name = "my TypeZ" block = "extension" final =
fextension" mixed = "true® =

cxsrannoctation =

=¥ rdocumentation =my typel
documentations/xg :documentations

</xs:annotation>
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cxg:complexContent id = "contentID" mixed = "false" >
<xg:extensicn base = "om:my Type® =
=xg:rattribute name = "gurname" type = "xs:string® /-

< /%8 extensions
= /xs:complexContent »
=z /xercomplexTypes=

=x&complexType name = "my Typei'
<xg: complexContent =
=xg:restriction bage = "nm:my Type" >
«xs:rall =
=xg:element name = "order" type = "ms:string®
i
=x8:element name = "orderl" type = "xs:string”
S =
z/xg:alls
«/xg:restriction=
= fxg:complexContent »
= /xs rcomplexTypes
x5 complexType name = "my Typed" =
=xg:simpleContent -
«xg:restriction base = "mg:gtring" =
=xg:minlength value = "2" />
< /¥s:restrictions
=/xz:zimpleContent »
< /xgcomplexTypes
=5 complexType name = "my Types" =
cxg:simpleContent -
<xg:extensicon basge = "wg:string® =
=xg:rattribute name = "attri" type = "ms:string" /-
< /%8 extensions
=fxs:gimpleContent »
=z /xscomplexTypes
«xg: complexType name = "my Type" abstract = "true" block = "extension®
final = "extension" id = "myTypelID" mixed = "crue" -
cxgrannotation =
<xg:documentation =my type
documentations/xs:documentations
= fxzrannotations
=xg:rattribute name = "name" type = "xs:string® /=
=xgrattributeGroup ref = "mm:attr group" /=

=xg:anyhttribute /=
< /xgrcomplexTypes
cxgrattributeGroup name = "attr group" [f-
< /%3 :schemaxs

attributeGroup

attributeGroup maps to simple UML Class with stereotype XSDattributeGroup.
e name — to UML Class name
e annotation — to UML Class documentation
e attribute — to inner UML Attribute or AssociationEnd with XSDattribute
e stereotype.

e attributeGroup - inner attributeGroup always must be just reference. Such reference maps to
Attribute or AssociationEnd with type of referenced attributeGroup. The opposite Association

End kind must be aggregated and it must be navigable.
e anyAttribute — to inner UML Attribute with stereotype XSDanyAttribute.
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If reference is generated, name is not generated.

When an <attributeGroup> appears as a daughter of <schema> or <redefine>, it corresponds to an attribute
group definition as below. When it appears as a daughter of <complexType> or <attributeGroup>, it does not
correspond to any component as such.

attributeGroup UML Model example:

<= AELErbl e U= -
attr_graup _hame {cﬁfﬂmﬁiﬁgﬁ
<< ¥=IEN YA bt = - : —
<<XSDalr butes=name  String =<XEDatributes=-aty  £ting
s RS0Eln Dute==-sumame ; sting

=<XS0schemas» <X EDatnbueGroup==
schema. xsd global_attr_group

fargetMamespace=h Lo nomagic.oom} =<XSDattribute > address © sting

<x8:schema xmlns:nm = "http://nomagic.com” xmlng:xs =
"hittp: //www . wl _org/2001 /XMLESchema” targetWamespace = "http://nomagic.com”
=
exgrattributetGroup name = "global attr group" =
=xgrattribute name = "address" type = "xs:string" [f=
= /xs:attriburedroups
exgrattributeGroup name = "atbtr group name” =

«¥8rannotation =
«¥8:documentation =attribute group
documentations/xs:documentations
=/xg:annotations
=xgrattribute name = "gurname" type = "xs:string" /=

«¥g:attribute name = "name" type = "xs:string" =
«¥S:annotation =
«xg:documantation =name attribute
documentations,/xs:documentations
< /®z2:rannotactions:
«/xg:attributes=
e¥grattributeGroup ref = "nm:global attr group2® =
«¥S:annotation =
«xg:documentation =reference
documentation=,/xs:documentations
/%= rannotarions
</xg:attributesroup>
<xg:anyAttribute /=
«/xg:actributedroups
e¥grattributedroup name = "globkal atbr group2" =
cxs:attribute name = "city" type = "xs:string” /s
< /xg:arcributedroups
</%xg:schema=
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simpleType

Maps to UML Class with stereotype XSDsimpleType.

XML Representation Summary: simpleType Element Information ltem

zgimpleType
final = (#all | (list | wmion | restriction))
id = 1D
name = HNCHame
famy areribures with non-schema namespace . =
Content: (annotation?, (reatriction | list | union)!
=/gimpleType:
zregtriction
base = QName
id = 1D
fany attributes with non-schema namespace . =
Content: (annotation?, (gimpleTvpe?,

WIWIWIMIWI

(minExclusive | minInclusive | maxﬂ

whitespace | pattern)*})

</restriction=

=list
id = Io
itemType = QOHame
fany attributes with non-schema namespace . =
Content: lagnotation?, (gimpleTvpe?))

=flist=

<union
id = ID
memberTypes = List of QName
{fany attributes with non-schema namespace B
Content: (aonotation?, (zimpleType*))

< /union>

Example:

=x8:simpleType name="farenheitWaterTemp" >
=¥8:restriction base="Xsg:number"=
<=xg:fractionDigics walue="2"/-
exg:minExclusive value="0_00"/=
exg:maxExclugive value="100.00",/=
«f®g:restrictions

=/xs:simpleTypes:

The XML representation of a simple type definition.

restriction

To specify restriction generalization must be used between this class and super class. This generalization has
or do not have XSDrestriction stereotype. Restriction id and annotation maps to Generalization properties.

In order to have inner simpleType element, parent of this Generalization must be inner Class of outer UML
Class.
list

UML Class must have additional stereotype XSDIist.
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Binding between this class and XSD:list must be provided.

“itemsType” maps to UML TemplateArgument from Binding.

union

UML Class must have additional stereotype XSDunion.

“memberTypes” and inner simpleTypes maps to several UML Generalizations between this simple type and
members types.

In order to have inner simpleType element, parent of this Generalization must be inner Class of outer UML
Class.
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Example:

Restriction example

number
Chtlp havimne a3 org 200 1MLS chiam &)

ﬂl'_

==x50zimpleTyne==»
TarenheitWater Temp == Rslsin ple Types»
aAnemmous

== X3 D ractionC gits == -FractlonC gits = 1{Mxed, [d=TationIgitzD §
==HSDilength==lenoth - wid = 1 0{id=length D, fiwed}
==H3iDmaExxlusives=-m a:Excluzsive  woid = 101 {fixed, id=m swexxlusiveid } .
==Habmadnduzsive == -madncluzive = 100{ixed, id=maxinclusiveid }
==dSDimaxlencgth==1nadlangth : woid = S0jicem adengthlD | ized=falzel
== 3D minExciusive ~=-mIiNExZusive D waid = 33[id=id, Txed}
==HSDminlnclusivess-m ininclusise = 1 00Hd=nininchsiseid, fed} ==d=DeimpleTes=
==H3ibminLength=#-m inLength : woid = 24{id=m inlengthlD | fizsd } dayTime
==faDpatiem==-psttern : void = [0-9)45 K-[0-9}4 07 {id=pattern_id}
== #3 DtctslDigite» = totaldigite = B{d=totalD igit=ID |, fived=falze] ==r=Denum emtion==day
==®3DwhileSpace = =-whileSpace | wld = preserweiled, ld=white_spaceid} el EEIEmL s e ol
=25 DwhiteSpaces=snhiteSpace] wid{ixed, id=white _spaceid, welue=prezerse’

String
Chitte:itensnneow3 orgd2001 Skl Schema)

=z BEDrestriction==

=<x=DeimpleTypes=
SBX
{inal=rzstriction}

==XEDenum eralion=>-12mn ale
==z xsDenumeralion=>-m alefid=som = _id }

=xg:schema xmlnsg:nm = "http://nomagic.com" xmlns:xs =
"heep:/ fwww . wi_ org/2001/XMLSchema” targetMamespace = "http://nomagic.com" =
«xg:aimpleType name = "farenheitWaterTemp"” =
«MESrannotation =
«x8:documentation =documentation of simple
types</xs:documentations
< /#g2rannotations
«Mg:restriction base = "®Z:number" =
«Xg:annotation =
zxg:documentation =documentation of
regtrictions /%2 documentations
< /®g:rannotations
=xg:pattern id = "pattern id" walue = " [0-%]{s8}(-[0-
o] falren =
“XSrannotation =
«x8:dogumentation =pattern
doc</xg:documentations
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</%¥2rannotations
</xg:pattern>
«#s:whiteSpace id = "white spaceid" fixed = "true" wvalue

"praserve’ -
£¥Srannotation =
exgrdocumentation =white space
doce,/xs:documentations
< /%2 :annotarions
</xg:whiteSpace=
«#s:whiteSpace id = "white spaceid" fixed = "true" wvalue

"preserve" >
«¥g:annotation =
exg:documentation >white space
doce,/xs:documentations
< /%2 :annotarions
z/xg:whiteSpace=
«xs maxlength id = "maxlengthID" fixed = "false" wvalue =
"EOP =
«¥g:annotation =
exg:documentation »max length
documentations/xs:documentations
</xgrannotation=
= /=g maxLength=
«¥s:minLength id = "minlengthID" fixed = "true" value =
nan =
«Xg:annotation =
exg:documentation »min length
documentations/xs:documentations
</xgrannotation=
< /=g :minLengths
«x8:length id = "lengthID" fixed = "true" value = "10" =
«xXS:annotation =
exg:documentation =length
documentations,/xs :documentations
< /®g:rannotaction=
< /xz:lengths=
«xs:fractionDigits id = "fractionDigitsID" fixed = "trua®
valug = "1" =
«xXS:annotation =
exg:documentation =fraction digits
documentations/xs:documentations
</wg:annotacrions
</xg:fractionbDigicss
«¥S:totalDigics id = "toralbDigitsID® fixed = "falze” walue
= "E" =
«XS:annotation =
exg:documentation =toral digits
id=/xg:documantaticns
< /®g:rannotaction=
</xg:toralbigicss

cxsmaxInclusive id = "maxinclusiwveid" fixed = "true"
value = "100" =
c¥xsrannotation =
<xg:documentation >max inclusive
documentation=/xs:documentations
< /®grannotacions
< /xa:maxInclusive:
cxs:minInclusive id = "mininclusiwveid" fixed = "true!

value = "100" =
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zxgannotation =
z¥g:rdocumentation =min inclusive
documentations,/xs:documentations
< /xsrannotations
«/#z:minInclusives
z¥8 maxkBExclusive id = "maxexclusiveid" fimxed = "trus"
value = "101" =
zxgannotation =
cs¥grdosumentation =max exclusive
documentations,/xs:documentations
«/xs:annotations
< /%2 maxExclusives
z¥g:minExclusive id = "id" fixed = "true" wvalue = "98" =
=Xgannotation =
cxg:documentation »min exclusive
documentation«,/xs:documentations
< /¥s rannotacions
</xg:minExclusives
«/xg:restrictions
</xg:simplaTypea=
«¥8:8impleType name = "dayTime" =
<xs:rannotation =
z¥g:documentation =day time
documentations,/xs:documentations
< /®g:annotation=
<¥s:restriction =
«¥g:annotation =
<xg:documentation >restriction
documentations=,/xs:documentations
</xgrannotations
«xg:2impleType =

«xg:restricrion base = "xs:number" /=
=/xg:s5impleTypes
«¥g:renumeration value = "day" =

«xgrannotation =
«xgrdocumentation =day
values«/xz documentations
< /%8 rannotacions
/%= enumerations
«xs:enumeration valus = "night" =
«xg:annotation =
«xgrdocumentation =night
values/xa2 :documentations
< /xsrannotations
/%= enumerations
< /wg:restrictions
</xg:simpleTypes
zxgrgimpleType name = " sex” final = "restriction™ =
«¥grannotation =
«¥s:documentation >documentation of simple type
restrictions</xs:documentation:
< /®g:annotations

«¥S:restriction base = "xs:string" =
sxg:enumeration id = "some id" walue = "male" /=
«xg:enumeration value = "female" =

x@annotation =
cxg:documentation »>female
values</xs documentation:
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«/¥z2rannotarions
< /®grenumerations
</xg:restrictions
</ xg:2impleTypes
« /%8 achemas

list example
<easbzchem ax
soham=
iem ¢ =50 zim pleT ypass
: 1 string
<mSDsimpleTepess
li=t
| <anDnHJDu3>
<b?m?aWS <4ma Dreslriction:»
< <bindingf>»
| <<umnn}>
245 Dz imple Teoe:» S0 zimplel e 425Dz mplaTepes »
Censlliz o CexaDlist = T AMONYMOUS
my_nurmbar_list my_numbar_list2
Pisid=l=il0}

«7xml wversion="1.0' encoding="UTF-8'7>

=xg:gchema xmlns:xe="http: //www.wl org/2001/¥MLSchema -
exg8:simpleType name="my number lisg2" =
exg:1list »
«xs:simpleType =
«xg:restricrion base="=z:string" /=
< fxg:2impleType=
</xs:1list>
</ xg:simpleTypes
«¥a: simplaType name="my number list" =
«xgrannotation =
«¥s documentation =my list
documentations,/xs:documentations
< /xg:annocations
<xg:list itemType="xs:boolean" />
</ x5:zimpleTypes
</xs:schemax
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union example

== ¥E0zIn pleType ==
(A == XEDEm pleT yes=

Hring
(ML Schema P rofle kttp: MosssnenS o 2001 ML Schetm =) e
_ (=ML Schema P rofle hitp: e nG arg SO0 ML Schema)
{ld=string }
=W SDwhiteS paces== - = pres ervelid=string presere} =
zersDrestriction==

; <=MI0=impeType==
F=HSD=simpleT ypes -

==xSDunion==
my_sinple_union

Junionld=wnion D}

= =m0 = mpleTye=s
==¥=D schem a== = =0unionz=
echerma . ed my_simple_union2
: . . ~
[targeitam espace=htp fnomagiccom | fumicnicl=unionlD §
«xg:schema xmlng:nm = "htep://nomagic.com® xmlns:xs =
"heep s/ fwww . wdoorg /2001 /XMLSchema” targetMamespace = "http://nomagic.com" =
«xg:8impleType name = "my simple union" =
«xs:unicn id = "unionID' memberTypes = "xs:string xs:number" /-
</xg:zimpleTypes
zxg:simpleType name = "my simple unien2™ =

«¥s:annotarion =
«xgrdocumentation =very important
documentarion«/xs:documentations
< /@grannotations

«¥s:union id = "unionID" memberTypes = "xs:number" =
«xg:gimpleType =
exg:restriction base = "xs:number” /=

«/xg:simpleTypes
< /®g1union=
</xg:zimpleTypes
< /xg:2chemas

minExclusive

Maps to UML Attribute with stereotype XSDminExclusive. Name and type of such attribute does not make
sence.

e value — to Attribute initial value.

¥ML Representation Summary: minExclusive Element Information ltem
zminExclusive

fixed = poglean : false
id = 1D
value = anyvSimpleTvpe
fany arrriburegs wirh non-schema namespace . . . J=
Conrtent: {aoootation?)
</minExclusive:

{valyel ‘must be in the -value space- of [hase type definition}.
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Example:

The following is the definition of a -user-derived- datatype which limits values to integers
greater than or equal to 100, using ‘minExclusive-.
=2impleType name='more-than-ninety-nine's

zregtriction base="integer':

eminBExclusive value="'99"/>

</restriction=
=/simpleTypex>
Mote that the -value space of this datatype is identical to the previous one (named ‘one-
hundred-or-more).

maxExclusive

Maps to UML Attribute with stereotype XSDmaxExclusive. Name and type of such attribute does not make
sence.

e value — to Attribute initial value.

AML Representation Summary: maxExalusive Element Information ltem

<maxExclugive
fixed = poolespn : false
id = ID
value = anvsimpleTvpe
{any attributes with non-schema namespace . . .j»
Content: l(annotation?)
< /maxExclusive:=
{value} -must be in the -value space: of {base tvpe definitiont.

Example:

The following is the definition of a -user-derived- datatype which limits values to integers less
than or equal te 100, using -maxExclusive-.
<gimplaType name='legs-than-one-hundred-and-one'=

<reégtriction bagse='integer'=

«maxExclusive value='101"'/>

</ragerictions
</gimpleType=
Mote that the -value space: of this datatype is identical to the previous one [named 'one-

hundred-or-less').

mininclusive

Maps to UML Attribute with stereotype XSDminlInclusive. Name and type of such attribute does not make
sence.
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e value — to Attribute initial value.

XML Representation Summary: minInclusive Element Information Item

«minInclusive
fixed boolean : false
id =
wvalue

anvSimplelyvpe
fany attributes with non-schema namespace . . .J»
Content: {annctation?)

</minInclusive:

{valye} -must- be in the -value space- of (base type defipition}.

Example:

The fellowing is the definition of o user-derived: datatype which limits values to integers
greater than or equal to 100, using *mininclusive-.
=zgimpleType name='one-hundred-or-more' =
<restriction base='integer's:
zminInclusive wvalue='100"'/=
</restrictions
=fgimplaTypes-

maxinclusive

Maps to UML Attribute with stereotype XSDmaxInclusive. Name and type of such attribute does not make
sence.

e value — to Attribute initial value.

XML Representation Summary: maxInclusive Element Information ltem

amaxinclusive
fixed = boolean : false
id = 1D
value = anyiimpleType
fany attributes with non-schema namespace . . .J»
Content: (anopotation?)
< /maxInclusives

‘must- be in the -value space- of {base tvpe definition}.

Example:

The following is the definition of a -user-derived- datatype which limits values to integers less
than or equal ta 100, using -maxlnelusive-.
<gimpleType name='one-hundred-or-lesg’s
=zrestriction base='integer'=
cmaxInclugive value='100'/>
</regtrictions
=/simpleType=

totalDigits
Maps to UML Attribute with stereotype XSDfotalDigits. Name and type of such attribute does not make sence.
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e value — to Attribute initial value.

XML Representation Summary: totalDigits Element Information ltem
<totalbigits

fixed = boclean : false

id = ID

value =

fany attributes with non-schema namespace . . .J}=

Content: {ggpotation?®)
=/totalDigits=>

Example

The tollowing is the detinition ot a -user-derived- datatype which could be used to reprasent
monetary amounts, such as in a financial management application which does not have figures
of $1M or mere and only allows whale cents. This definition would appear in a schema
authored by an "end-user” and shows how to define a datatype by specifying facet values which
constrain the range of the -base type: in a manner specific to the -base type- (different than
specifying max/min values as before).
«s5impleType name='"amount '
<ragtriction bage='decimal'=
=totalDigits value='8'/>
<fractionDigire value='2" fixed='true'/=
«/regtrictions
«/gimpleTypes

fractionDigits
Maps to UML Attribute with stereotype XSDfractionDigits. Name and type of such attribute does not make

sence.

e value — to Attribute initial value.

XML Representation Summary: fractionDigits Element Information ltem

«fractionDigits
fixed = hboolean : falze
id = 1D
value = pnonMegativelInteger
fany acrribures with non-cchema namespace . . . fa
Content: (gonotationz)
</fractionDigits>

Example
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The following is the definition of a ‘user-derived- datatype which could be used to represent
the magnitude of a person's body temperature on the Celsius scale. This definition would appe
in a schema authored by an "end-user’ and shows how to define a datatype by specifying facet

values which constrain the range of the ‘base type-.
=g2implaeType name='gcelsiugBodyTemp' =
zregtriction base="'decimal’=
=stotalDigits value="41/>
<fracticnbigits value='1"'/=
cminInclusive value='36_4'/>
cmaxInclusive value='40_5'/>
efregtriction=
=/gimpleTypes

lenght

Maps to UML Attribute with stereotype XSDlength. Name and type of such attribute does not make sence.

e value — to Attribute initial value.

XML Representation Summary: length Element Information Item

zlength
fixed =
id = 1D
value =
fanp arrribures with non-schema namespace .
Content : (annotation? )

z/length>

boolean @ false

s

Example

The following is the definition of a -user-derived- datatype to represent product codes which
must be exactly 8 characters in length. By fixing the value of the length facet we ensure that type
derived from productCode can change or set the values of other facets, such as pattern, but

cannot change the length.
=simpleType name='productCode ' =
«restriction base='string's=
<length wvalue='8' fixed-='true'/-
</restriction>
=/simpleType=

minLength

Maps to UML Attribute with stereotype XSDminLength. Name and type of such attribute does not make sence.

e value — to Attribute initial value.

106

Copyright © 2009-2011 No Magic, Inc.



XML Schema Mapping to UML Elements

XML Representation Summary: minLength Element Information ltem
zminLength

fixed = bgolean : false
id = I

value =
fany atrributes with non-schema namespace . . . J=
Content: [annotation?)

= /minLength:s

Example

The following is the definition of a -user-derived- datatype which requires strings to have at
least one character (i.e., the emply string is not in the ‘value space: of this datatype).
=gimpleType name='non-empty-string'=
<=rggtriction bage='string'=
sminLength value='1'/>
e /ragerictions
</gimpleTypes

maxLength

Maps to UML Attribute with stereotype XSDmaxLength. Name and type of such attribute does not make sence.
e value — to Attribute initial value.

XML Representation Summary: maxLength Element Information ltem

«maxLength
fixed = poglean : false
id = ID
value = noudegativelnteger
{fany artributes with non-schema namespace . . .J}=
Content: {annotation?)
< /maxlengths=

Example

The following is the definition of a -user-derived- datatype which might be used to accept form
input with an upper limit to the number of characters that are acceptable.
<gimplaType name='form-input’=
z=restriction base='string'=
<maxlength value='80*/>
</restriction=
</gimpleType:>

whiteSpace

Maps to UML Attribute with stereotype XSDwhiteSpace. Name and type of such attribute does not make sence.
e value — to Attribute initial value.
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XML Representation Summary; whiteSpace Element Information ltem

zwhitefpace
fixed = hboolean @ false
id = LI
value = {(collapse | pregerve | replace)
fany attributes with non-schema namespace . . . /=
Content: (annotation? )
</whiteSpaces>

Example

The following example is the datatype definition for the token -built-in- -derived- datatype.
zgimpleType name='tcken':
<restriction hase='normalizedString!=
swhiteSpace value='collapse'/>
= frestricrion:

= /eimpleTypes>

pattern

Maps to UML Attribute with stereotype XSDpattern. Name and type of such attribute does not make sence.

e value — to Attribute initial value or TaggedValue with name ‘value’.

XML Representation Summary: pattern Element Information ltem

zpattern
id = 1IQ
value = anviimpleTvype
fany attributes with pon-schema namespace . . .J}»
Conrent:  (gnnotationt )
=/patterns
{volue} -must be a valid -regular expression-.

Example

The following is the definition of a -user-derived- datatype which is a better representation of
postal codes in the United States, by limiting strings to those which are matched by a specific
-regular expression:.
<gimpleType name='better-us-zipcode':

=restriction base='string'=s

<pattern value='[0-9]{5}{-[0-9]){4})2" />

«/regtrictions

</simpleType=>

enumeration

Maps to UML Attribute with stereotype XSDenumeration.
e value — to Attribute name.
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XML Representation Summary: enumeration Element Information Item

canumeration
id = ID
value =
{fany areribures wirh non-schema namespace . . . J=
Content: (annolatioh?)
< fenumerations

Example

The following example is a datatype definition for a -user-derived- datatype which limits the
values of dates to the three US holidays enumerated. This datatype definition would appear in a
schema authored by an "end-user” and shows how to define a datatype by enumerating the
values in its -value space-. The enumerated values must be type-valid literals for the -base
type-.
<gimpleType name="holidays'=
zannctations
=documentaticn=socme US holidays</documentation:
< fannotations
<restriction base="gMonthDay'=>
zenumeration value="--01-01'>
zannotations=
=documentation=Hew Year's day=/documentation=
=/annotations>
< /anumerations
cgnumeration value="--07-04'>
zannotation=
«zdocumentaticn=4th of July=</documentations
= /annotation-
< /fenumerations
zanumeration value="-=-12-2§5">
zannotations
zdocumentaticn=Chrigtmas=/documentations
=/annotation=
</enumerations
<frestriction=
</gimpleType>

unique

Maps to UML Attribute added into some UML Class.

sunigue
id = ID
name =
fany attributes with non-schema namespace . . .J=

Content: {(gonotation?®, (selector, field+))

= /uniques

unique UML Model example

For an example, see “keyref UML Model example” on page 111
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key

Maps to UML Attribute added into some UML Class.
e name — to Attribute name.

e id — to TaggedValue.

ckay
id = 1D
name = HNCHName

fany attributes with non-schema namespace .

g
Content: (gonotation?, (selector, fislds))
=/keys
key UML Model example
For an example, see “keyref UML Model example” on page 111
keyref
Maps to UML Attribute added into some UML Class.
o refer — to value of “refer” or “referString” TaggedValue.
e name — to Attribute name.
e id — to TaggedValue.
<keyref -
id = 1R
name = NCHame
raefer = ONape
fany arcribures with non-schema namespace . . . =

Conrenr: (annotation?, (selector, field+) )
< /kayrafs
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keyref UML Model example

ssEbechemas=
e hema

fargetMam ezpace=http:inomagic.com,
Anlnsnm =kp: fnomagic.com )

SR
== WsDighem ent==-person  personT e
==k=Delam ent==-toat : raotTyedkey_unigue_keyRef=state, wehicleState, regbey, carf e f}
==HSDzlom ent==-state ; stateType{key_unique_key R f-reg }
== K=Delem ent==wechicle : wchicleTwe
VIR
==K=Bkeys=regkeyeelector=SMehide | field= @etsts | @plstetum ber}
== KzDkey=-state{1eld=code , selecior=Jistate
S eTr Tt
==KEDkieyR af==caRe{zalectar= dicar, field=@regstste, EregP late  redr=reghkiey]
==KZDkey efr=~w=hicleState{refer=ztate, selector=Jifehide | field=@slal= )

SO i A TR
==k=D#hique==-rea{idd=m@plateM umber, selector= Wehicle}

it

=« MEDeomplerTypes== == W=Dicom plexTypes = =50 com plexTypes=
=< M3D sequence== =<5 =equence== s=H3D=eguence==
rootType pereonlype etateType

==HEDekm ent-= -stateR e f[*|{ref=state } | =«HSDelem ert=r-car : carTyps = =HSDelem ent==-code : twol etters ode

==xalelement==-perzonfef [*liret=perzon}
= =S 0elem ent==-whicleRaf [*jref=wechicle }

=iring
oD oomplepenn = XEDCamplexT yes»
=z N=Dall==
T ==zHEDsequencas= -
T“ I vet hicle Type
4= HSDain plaTypa== - — == W3 Dattributes=-patefumber Jinteasr
=«maDattribute==reqPlate | integer . . .
twol etter Code == WED atrib ute= = ey State : teoleterCode PSR BT 15 £ el S Bel
zxg:gchema xmlns:nm = "hotp://nonagic.com” xmlng:xs =
"hetp: //www. w3 org/2001 /¥MLSchema” targetNamespace = "htrop://nomagic.com” =
=®g:alement nams = "vechicle" =

«xg:complexType =
=xs:all =
«xg:attribute name = "platedNumber' type = '"xs:integer® /-
«#g:attribute name = "gtate" type = '"nm:twoletterCode" /f-
= /xg:complexType:x
</x5:element=
<xg:element name = "state" =
«®g:complexType =
<XES:seguence
<«x8:element name = "cgode" type = "nm:twolLetterlode" /=
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zxg:elaement ref = "mm:vechicle" maxOocurs =
"ynbounded® /=
cxg:elament ref

"nm:person” maxicours =
"unbounded® [f=
= /xgsegquences
</ xz:complexTypes
ex¥s:unique name = "reg" =
«Xg:annotation =
zxg:documentation »unigue
documentation«/xs:documentations
< /%2 rannotations
«xg:gelector xpath = . //vehicle” /=
«xg:field xpath = "g@plateNumber" /-
=/xs:unigques
</xg:element=
zxg:relement name = "person” =
axscomplexType =
<X§:seguence =
zxg:element name = "car" =
<& complexType =
<xg:gequence /=
«¥grattribute name = "regPlate" type

fxg:integer® /s
cxgrateribute name

"regitate" rype

"nm: twoletterCode® [=
= /x5 complexTypes
«/xs:elemant =
< /xg:gagquences
</xg:complexTypes>
</xg:element=
«xg:element name = "roob" =
«¥srcomplexType =
<X§:seguence =
zxg:element ref = "nm:state” maxOccurs = "unbounded”
[ =
= /xg: gsaguence=
</ xg:complexTypes

«¥s:key name = "state" =
<xg:gelector xpath = "_//state" />
zxg:field xpath = "code" />
</ xz  keys
«¥a:keyref name = "vehicleStare® refer = "nm:state® =
zxg:gelector xpath = " //vehicle® /=
zxg:field xpath = "@state” /=
«/xz : keyref-
«¥g:key name = "regey" =

=¥s:annotation =

zxg:documentation =kKey
documentations/xs:documentations
< /%2 rannotations

zxg:gelector xpath = . //vehicle” /=
zxg:field xpath = "mstate" /=
«xg:field xpath = "g@plateNumber" /-
=/xg:key>
«¥s:keyref name = "carRef" refer = "nm:regey" =

«xg:annotation =
exg:documentation =key ref
documentations,/xs:documentations
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< /¥a:annotations

zxg:gelector xpath = "_/fcar"
«¥s:field xpath = "@regState”

«xs:field xpath = "@regPlate" /=

</xg :keyref:
</x5:elements
«¥8:simpleType name = "twolLebtterCode”

e

/=
/=

«xg:restriction base = "®s:string" /=

=/xg:gimpleTypes

< /%5 :achema:

selector and field

Maps to UML TaggedValues named “selector” and “field” of UML Attribute representing key,keyRef or unique.
“selector” tag has value representing “xpath” and “field” - list of valuesrepresenting field “xpath”. ID values shall
be skipped and annotation documentation will beapplied to tagged value according to annotation rule
(see:annotation). For field valuesannotation documentation shall be merged in one.

zgelector

id = ID

?path = & subset of XPath expression, sec below
a Lo

. atfribures with nopn-scofiema pamespace .
Content: |annoLation?)

«/selectors
<field

id = LD

?path = & subset of XPath expression, see below
an e

I attributes with non-scfiema namespace .
Coptrent: (annotation?)

«/fields

=

Example

113

«xg:key name="fullName"
=xg:selector xpath=".//person"/=
«xg:field xpath="forename" /-
zxs:field xpath-"surname" />

=/x8:key=

exg:keyref name="perscnkRef” refer="fulllName
<xg:gelector xpath=".//perscnPointer”/=
zxs:field xpath-"@first"/>
«xg:field xpath="@lasc" />

= /xg:keyraf>

=Xg8:unigque name="nearlyID"=
=xg:selector xpath=".//+" />
<xg:field xpath="gid"/=
=/xg:unigue>

LY
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XML representations for the three kinds of identity-constraint definitions

Example

eXg:element name="gtate":=

=x8: complexTypes
<¥8:g8egquences
<xXg:element name="code" type="twoletterCode"/=
exg:alement ref="wvehicle" maxOccurs="unbounded® /=
=xg:element ref="person" maxdccurs="unbounded" />
</xg:sequence=

=/xg:complexTypex>

<xg:key name="reg": =!-- wehicles are keyed by their plate within states
=->
<xg:gelector xpath=".//vehicle" /=
<xg:field xpath-"g@plateNumber" />
=/xz keys
=fxg:element >

exg:alement name="root's
X8 complexType:=
<¥8:8egquences

<xs:element ref-"state" maxOcours="unbounded"” /=

</xg:sequence=
=/xg:complexTypes=

<x5:key name="state"> <!-- states are keyed by their code --=
=xg:gelector xpath=". //state”/>
<xg:field xparh="code"/=

<fxg:kay>

=xg:keyref name=FvehicleState" refer="gtate':
<!l=-- every wvehicle refers to its state --=
<xg:8elector xpath=".//vehicle" /=
«xs:field xpath="Estate" />

=/xg :keyref=

=xg:key name="regKey"s <!-- wehicles are keyed by a pair of state and pl:
-—

<xg:gelector xpath=".//vehicle" />

=xg:field xparh="@state' /s

=xg:field xpath="gplateNumber" />
=/xg :key=>

cxsg:keyref name="carRef" refer="regkKey"s> =<!-- people's cars are a
reference --=
<xg:gelector xpath="./ car"/=>
=xg:field xparh="@regStare’ />
<xg:field xpath-"@regPlate’/=
=/xg:keyref=

zfx5:element =
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«xs:element name="person":
<38 : complexTypes
X8 : Sequence:s

<xs:element name="car"s
<8 complexTypax
<xg:attribute name="regState" type="twoletterCode"/-
<xg:attribute name-"regPlate" type-"xg:integer"/-
< /%8 : complexTypes
< /xg:alemants
< /%8 :sequences
= /x5 complexTypes
< /xg:element =

A state element is defined, which contains a code child and some vehicle and person children. A vehicle in turn
has a plateNumber attribute, which is an integer, and a state attribute. State's code s are a key for them within
the document. Vehicle's plateNumber s are a key for them within states, and state and plateNumber is asserted
to be a key for vehicle within the document as a whole. Furthermore, a person element has an empty car child,
with regState and regPlate attributes, which are then asserted together to refer to vehicles via the carRef
constraint. The requirement that a vehicle's state match its containing state's code is not expressed here.

selector and field UML Model example

For an example, see “keyref UML Model example” on page 111

annotation

Maps to UML Comment with or without stereotype XSDannotation.
Documentation’s content maps to UML Comment body(name).

“documentation” maps as UML comment:
e “content” value shall be comment name
e “xml:lang” value — tag “xml:lang” value

e source value — tag "source” value

“appinfo” maps as tag value with name “applinfoSource”:
e “source” value will be tag value

e “content” will be documentation for tagged value

Appearing several annotation nodes on one element node, mapping shall be done in following way:

e “documentation” text shall be merged into one UML comment with merged content, but
“content” and “xml:lang” tag values shall represent only first matched values
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e “appinfo” shall have: “content” merged into one tag “applnfoSource” comment, but tag value
shall represent first matched “appinfo”

XML Representation Summary: annotation Element Information ltem

<annotation
id = 1D
fany attributes with non-schema namespace . . .J=
Conrent: l(appinfo | dogumentation)*
</annotations
<zappinfo
source = gnvigEls
Content: | fanyl)+*
=/appinfos
zdocumentation
source = anyviRI
#*xml:lang = >
Content: | fanyl)+
=/documentations

Example

«x5:8impleType fn:note="specialf=
<xg:annotation=

=xs:documentation=A type for experts onlys</xs:documentations
<xg:appinfo-

<fn:sgpecialHandling-checkForPrimes</fn:specialHandling>
</xg:appinfo=
c/xsannotations

XML representations of three kinds of annotation.

annotation UML Model example

¢S Dannotaiony s
the documentation for this schema

{fapplrfaConient=infolCant2nt,
appinfoSource-infoSaurce,
wrl:lEng=E M,
source=documentation s ourc2}

<2305 chemaz »
schema
{tergeitarn es pace- httpodhomed ¢ com.
strilng:nm =hitp: i omegiccom}

«xg:schema xmlng:nm = "htop://nomagic.com" =mlng:xs =
"hetp://www . w3 _org/2001/XMLESchema” targetMamespace = "http://nomagic.com" =
«MErannotation >
<xs:appinfo source = "infoSource" sinfolontente/xs:appinfos
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«xgrdocumentation source = "documentation source" xml:lang =
"EN" =the documentation for this schema</%s:documentations
</ /®xs:annotations
</xg: schemax

compositors

Complex type maps to UML Class with stereotype XSDcomplexType. In order to have some group in complex
type, the same UML Class also must have XSDall, XSDchoice or XSDsequence stereotype.

UML model can have ModelClass just with single stereotype XSDall, XSDchoice or XSDsequence. In this case
such class maps to inner part of other group.

Elements order in sequence group is very important. Such elements are ordered according values of
TaggedValue sequenceOrder.

s

<all
id = Ip
maxQOcours = I @ 1
mindcours = (& | I} : 1
{any artributes with non-schema namespace . . . J»
Content: (aognotation?, element*)
«falls
zchoice
id = 1D
maxQcours = (gonoNegatjvelnteoer | urbounded) : 1
minOccurs = poplNegativelpteger : 1
{any artributes with non-schema namespace . . . J»

Content: (aonotation?, (element | group | choice | seguence | aoyl*)

z/choices

sgegquence
id = 1D
maxQcours = (nonNegativelInteger | unbounded) 1
minOccurs = popNegativelpteger : 1
{any attributes with non-schema namespace . . . J=
Content: (aogpotation?, (element | group | choice | seguence | aov)+)
=/ sequence:s
Example
«xs:alls

cxg:element ref="cats"/>
=xg:alement ref="dogs"/=>
</xg:alls

=XS:seguence:
<xg:choices
cxg:aelement ref="lefr'/=
<xg:element ref=Frighect/s
< /xg:choicas
cxg:element ref="landmark"/>
=/ x2:sequences

XML representations for the three kinds of model group, the third nested inside the second.

compositors UML Model example
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=S50 0rup= =
==R80saquance==

ryGroup
[id=group id,
rhin Qecy rs=2,
rmaEdce urs=1,
choiceld=choiczid]

==¥S0ary==-ary 0. 1{namespace=yalue, id=anyID, SequUencerumber=7t

“=xSDgroupRef==-goup3Ref: hitphamagic.com:myGroup 2 [0 1= aquanceklumbar=21
==pSDelement==-name . htlpfoww o3 orgdZ00155M LS chema: string{sequenceCrder, sequenceMumbe—=4 }
z=x¥SDelament==-nameal : kitp: e 3 org 20 07 BMLS cham 3 eringlsaque ncaMumbai=&1
s=adDelement==-namez . ftp: et w3020 00 HpLS chema. sring{seque nceMumbe=a}

l:"".

0.x leaquancerurmber=13)

==ggbgroup==
=< B0a ==

myGroup?2
<=xSDelame nt==-curname : hitp: s wd arg 20018 LS chemasiting

=350 hoic g==
Compositor
fsequence Mumber=1]

==rSDelement==-number: htlpoitssess 2orgl2001=MLE che ma;:string

==r¥o0group==
==RSDcholces=»

myGroupd
=<x50e lement==-address ; http: P wd org 2001 =M LS chemastring

<?xml version='1.0" encoding='Cpl252'?x>

=xg:schema xmlng:nm = "http://nomagic.com" xmlns:xs =
"hetp://www . wl . org/2001/4¥MLEchema” targetMNamespace = "http://nomagic.com" =
<HE:group name = "myGroup” s

«xsrannotation =
zxg:rdocumentation =my group
documentation,/xg:documantations
< /xgrannotations

«¥E8:8aguence mindOccurs = "2" maxOccours = "1" =
«x8:choice =
=xg:element name = "number” bype = "Hs:string® [s
/%2 :choices
exs:group ref = "nm:myGroupd” mindccurs = "0" maxOccurs =

e .
sxg@rannotation =
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exg:documentation =ref
documentations/xs:documentation=
z/xgrannotations
=/xg:group>

«¥S:group ref = "nmimyGroup" mindccurs = "0 maxOoccurs

"unbounded” =
«¥g:annotation =

cxgrdocumentation another ref
documentations/xs:documentation=
z/xgrannotations
</xg:group>
cxs:element name
zxs:element name

"mame" cype = "xXs:string® /s
"nameZ" type "xg:gtring” /-

«xg:element name = "namel" type "xg:agtring” J-
«¥s:any id = "anyID" namespace = "value" minQOccurs =
maxfcours = "1" /=

< /%8 zequence:s
< /%8 groups
«¥B:Qroup name = "mySroupi™ >
<xg:choice =
«xs:element name
< /xg:choices
< /®s:group>
<MS:Qroup name = "myGroup2® s
=¥g:all =
«xgrelement name
</xg:all=
< /%3 groups
< /%8 achemaxs

"address" type "wg:string" fs

"gurname" type

tyg:gtring" f»

group
Maps to UML Class with stereotype XSDgroup.

This class also may have stereotype XSDall, XSDsequence or XSDchoice.

If group has ref attribute, such group definition maps to UML Attribute or UML Association End. UML Attribute

must have XSDgroupRef stereotype. This stereotype may be omitted for AssociationEnd.

XML Representation Summary: group Element Information Item

n DII

sgroup
nama = HCNames
Content: (anmotation?, (all | gchoice | zeguence))

= fgroups

=g roup
ref = Qiame
maxOcours = (nonNegarivelnreger | unbounded) 1
minQcours = poplegatjvelpteger : 1=

Content: (annotation?)
< /group=
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Example

=X§:group name="myModelGroup" s
<¥E5:gequance:=
<=®g:element ref="someThing" /=

< /xg:sequencex
< /%8 :group=

<xg:complexType name="trivial"s
<xg:group ref=-"myModelGroup" /=
=xs:attribute ... /=

= /x2 :complexTypes

=8 :complexType name='moreso" s
=xg:choices
«zxg:element ref="anctherThing" /=
«exg:group ref="myModelGroup”/=
< /xg:choice:
<xg:attribute .../ =
= /xs :complexTypes

group UML Model example

For an example, see “compositors UML Model example” on page 117

any and anyAttribute

Maps to UML Attribute with stereotype XSDany or XSDanyAttribute.

maxQccurs - to multiplicity upper range. Value unbounded maps to asterisk in UML.

minOccurs — to multiplicity lower range.
annotation maps to Attribute documentation
Other properties to TaggedValues.

XML Representation Summary: any Element Information ltem

any
id = ID
maxCcours = (gooMegativelpbeosar | unbounded) : 1
minQcours = i : 1
namespace = | {##any | ##other) | List of {apyURI |
##locall) ) flany
processContents = (Jlax | skip | strice) : strict
{any artributes with non-schema namespace . . . J}s
Content: (agpotation?)
=/anys=
canyAttribute
id = ID
namegpace = | (##any | ##orher) | List of (agyURI |
##locall) |} #Hany
processContents = (Jlax | skip | serice) : strice
{fany areribures wirth non-schema namespace . . . J=
Content: (annotation?)
= fanyArtributes

| ##targetNamespace |

| ##rargerNamespace |
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Example

<Xg:any processContents="skip"/=>

<¥Xg:any namespace="##other" processContents="lax"/>
=Xg:any namespace="http://www_ wi._ org/1993/X5L/Transform" />
<Xg8:any namespace="##targetNamespace" /=

<xg:anyAttribute namespace="heep:/ fwww. wl. org/XML/1998 ‘namespaca” /=

XML representations of the four basic types of wildcard, plus one attribute wildcard.

any and anyAttribute UML Model example

==XsDhachema=>»
achema

[taraethlam espace=htip fnom agic.com ,
anlnznm =hthe:vnomagic.com b

=z X=DattributeGroups=
atir_group

==xs0anyiitbute> =-anyl {processContents=skip, namespace=htpbla.bla bla, id=anyl }

==HSDgroup==
==X=0choicas=

my_type

2=X50 any==-any[0 .1 }d=anyl, processContents=strict, nam espace =http:phla}

<?xml wversion='1.0' encoding='Cpl252'7>

=xg:schema xmlns:nm = "http://nomagic.com” xmlns:xs =

"hetp: /fwww. w3 org/2001/¥MLESchema” targetNamespace = "http://nomagic.com”
=
XS :group name = "my type' =
«xg:choice =
«xg:any id = "anyID" namespace = '"htep://blan®
procesafontents = "strict” mindcours = "0" maxOcours = "1" =

=¥§rannotation =
exs:documentation =any
documentations/xs:documentations
< /%2 rannotations
= /xg:any>
</xs:choicex
= /%8 groups>

exgratbributeGroup name = "abtbtr group” =
sxgranyAttribute id = "anyID" namespace = "http:ibla.bla.bla”
processContents = "skip" =

«¥sannotation =
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«xs:documentation =any attribute
documentatione, /xs:documentations

< /®grannotacions
= /xganyattributes
«/xg:arcributedroups
< /%g:zchemas

schema

Maps to UML Class with stereotype XSDschema.
All schema global attributes and elements are mapped to UML Attributes of this class.
Name of this class should match file name or must be assigned to the component, which represents file.

“xmins” xml tags maps to an permission link with stereotype «xmins» and name, representing given prefix.
Permission client is schema class and supplier package with name equal to the “xmins” value.

XML Representation Summary: schema Element Information ltem

=schema
attributeFormbefault = (gualified | wungualified) : ungualified
blockbefaulr = (#all | List of (extemsion | restriction | substirution))
(8]
elementFormbefaulr = (gualified | ungualified) : ungualified
finalbefault = (#all | List of {extension | restrictiom)) : '!
id = ID

targetMamespace = aoylURl

version = rtoken

xml:lang =

fany artribureg wirh non-schema namespace R £

Coprent: {((include | import | redefine | anncotaticn)*, ({{simpleTvpe |
wjl\mlwnlwlmlwh
annetation i
=/schemas=

Example
=3x8 schama
xmlng:xs="htep: / /fwww.wi._ org/2001/¥MLSchema™
targecHamespace="hetp: //www.example . com/exampla’s

=z /x®a:schemas

The XML representation of the skeleton of a schema.
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schema UML Model example

== alschema==
schema.xsd

JatmbuteFannCefault=qualified,
blockDefaul i=eAersion,

&l ermertFomrnCefault=ungualified,
finzl0efault=estension,

version=1.2,

Aanllang=EN,

targetMame space=ht/hormagic.com}

| |
<2arins== |

i | ==qTins== | ==pmins ==
| |n m

| ‘ |
| | |
==y hamespace== ==rE0namespace>>

hitp: fvwwww.ow3.org/2001 X MLSchema htip:fnomagic.com

=xg:gchema xmlns:nm = "heep:/ /nomagic. com”
xmlng:xs = "hetp://www.wl . org/2001/¥MLEchema
xmlng = "http://nomagic.com”
attributeFormDefault = "gqualified"
blockDefault = "extension"

elementFormbefault = "unqualified”
finalDefault = "extension"

targetNamespace = "htoop://nomagic.com®
version = "1.2"

xml:lang = "EN" />

notation

Maps to UML Attribute with stereotype XSDnotation. This attribute must be added into UML class with
stereotype XSDschema.

e name maps to UML Attribute name

e annotation maps to UML Attribute documentation.

XML Representation Summary: notation Element Information ltem

cnotation
id = 1D
name = HNCName
public = anylURI

system =
fzny arrribureg with non-schema namespace . . . J}=
Content: {annotation?)

< /notations
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Example

<xg:notation name="jpeg" public-="image/jpeg" system="viewer.exe':

The XML representation of a notation declaration.

notation UML Model example

s=x50echamar=
schema

ilargeiame space=httpnomagic.com,
¥mins nm=httpnamagic com?

==HO Dnotatio n==- jpeg{systerm=viewer exe, public=irna gefpey}

«xg:schema xmlng:nm = "htep://nomagic. com
#mlng:xs = "hetp: //www. w3 . org/2001/XMLSchema
targetNamespace = "http://nomagic.com" >
«xg:notation name = "jpeg" public = "image/jpeg" system = "viewer. axe"
/=

« /s schemas

redefine

Maps to UML Class with stereotype XSDredefine. This class has inner UML Classes as redefined elements.
Every redefined element must be derived from other UML class with stereotype XSDsimpleType,
XSDcomplexType, XSDgroup, XSDattributeGroup. The name of this class shall match “schemalLocation”
value.

If two “redefine” with the same schema location appears, they shall be merged to the one and the same class
with a name “schemalocation”.

Redefine Class must be inner class of XSDschema Class.
e annotation - to XSDredefine UML Class documentation

e schemalocation — to XSDredefine UML Class name.

XML Representation Summary: redefine Element Information ltem

sredaefine

id = 1D

schemalocation = v

fany attributes with non-schema namespace . . .[J»

Conrent: (apnotation | (simpleTvpe | complexType | group |
attributeGroup) | *
zfredafines

Example
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vl xsd:
=x8:complexType name="persontamsa":
<XS:segquences
ex¥g:2lament name="title” minQOccurs="0"/=

«¥s:2lement name="forename® mindOccurs="0" maxOccurs="unbounded® =
=/ x3: sequences

</xg: complexTypeas>
=xg:element name="addresgee" type-"personMame"/>

va . xsd:
«x8:redefine schemalocation="vl.xsd"=>
<X5:complexType name="personNams’ -
<¥8: complexContent »
=xg:extension base="perszoniama’ =
<XS:Seguences
<xg:alement name="generation" minCcocurs="0"/=
< fxg:sequences-
«/xs:extension=
< /%5 : complexContent
< /x8: complaxTypes
«fxg:redefines

«xg:element name="author" type="persontame"/:

The schema corresponding to v2.xsd has everything specified by v1.xsd , with the personName type redefined,
as well as everything it specifies itself. According to this schema, elements constrained by the personName
type may end with a generation element. This includes not only the author element, but also the addressee
element.

redefine UML Model example

s<¥G0schema==
schamaxsd

{tarmettlamespace=ht fhomagic.com)

<HE0redefine=x= <=l imple Type ==
hitpnomagic.com - string

==x=Drediriction==

=50 mplaType==
string
(ML Schema Profile httpofesess wd org 200 148MLSchema)
Jid=stnng}

=EDwhite Space==> = greservelid=stnng. presenel
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<?xml version='1.0"' encoding='UTF-8'?>

=xg:schema xmlng:nm="http://nomagic.com”
xmlns:xs="htep: //www. w3 org/2001/MLEchema
targetNamespace="http:/ /momagic.com" =
cxg:redefine schemalocation="http://nomagic.com” =
«xs:simpleType name="string" =
«x8:annotation =
exg:documentation »my
documentations/xs:documentations
</xgrannotations=
«xg:restriction base="xsg:string" /-
=/xg:simpleTypeas
< /xg:redefines
</%xg5:schema=

import

Maps to UML Permission with stereotype XSDimport. Permission client must be schema class stereotypes

«XSDschema» Component, supplier namespace Package XSDnamespace.
e namespace maps to supplier name.
e annotation maps to UML Attribute documentation.

e schemalocation maps to TaggedValue.

XML Representation Summary: import Element Information ltem

cimport
id = 1D
namespace = AQVIEL
gchemalLocation =
fany arcribures with non-schema namegpace . . . =
Content: (aopotation?)
=/ imports

Example

The same namespace may be used both for real work, and in the course of defining schema components in

terms of foreign components:
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<schema xmlng="http:/ /www.w3.org/2001/XMLSchema"
xmlng:html="http: / fwww. w3 org/199%9 /xhtml"
targetMNamespace="uri:mywork" xmlns:my="uri mywork":

<import namespace="htep://www.w3. org/199% /xhtml" /=

cannotations
zdocumentations
<html:p>[Some documentation for my schema)=/html:p=>
< /documentations
</fannotation=

zoomplexType name="myType":=
zgaguencas
<element ref="html:p" minOcours="0"/>
</sequences

=/complexType =

zglement name="myElt" type="my:myType"/=>
< /achemas

The treatment of references as ‘QNames - implies that since (with the exception of the schema for schemas)
the target namespace and the XML Schema namespace differ, without massive redeclaration of the default
namespace either internal references to the names being defined in a schema document or the schema
declaration and definition elements themselves must be explicitly qualified. This example takes the first option -
- most other examples in this specification have taken the second.

import UML Model example
1

=={E0NEMESpAE ==
______ _-| bt sl w3 e ng 1 988 s html|

<<HEDim part==
i=chem aLlocationshlp dteeseeond orgH 393000m1

=« ¥ED zchemea == |
sehema s sd =<k¥ZDnamespacs= =
ABFGET A esp Ace=NTE: MM AgIc Com } http Arww . w2.org /200 12X MLS chema
< Ing=>
=xg:schema xmlng:nm = '"htep://nomagic. com" xmlns:xs =
"hetp: S fwww . wd . org/2001,/XMLEchema™ targetMNamespace = "htep://nomagic. com" -
=¥g:import namespace = "http://www.w3 . org/19%3/xhtml" schemalocation

= "http: /fwww.w3 . org/199%/xheml" />
< /xs: schemas
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include

Maps to UML Component with stereotype XSDinclude. Component must be added into xsd file component.
e annotation maps to UML Component documentation

e schemalocation maps to UML Component name.

XML Representation Summary: include Element Information ltem
zinclude
id = ID
schemalocation =

fany ateributes with non-schema namespace . . . /=

Content @ (gnnotation= )

</includes

include UML Model example

schema.xsd

o=l cludess
httpdfnom agic.comischema.xsd

«xs:2chema xmlns:nm = "http://nomagic.com” xmlng:xs =
"http://www. w3 . org/2001 /XMLSchema” targetNamespace = "http://nomagic.com”
=

«xg:include gchemalocarion = "heoop://nemagic.com/schema.xed” /=
< /%2 achemas

XML schema namespaces

Maps to UML Package with stereotype XSDnamespace. In order to define “xmlIns” attribute in the schema file,
Permission between XSDnamespace package and XSDschema class must be added into the model.

e The Permission name maps to namespace shortcut.

Example:

<x5: schema

xmlng:xs="http://www.w3.org/2001/XMLSchema"
xmlns="http:/ www.wl_ org/2001/XMLSchema”
targetMamespace="http: //www.exanple . com/example" -

< /%8 : achemax

The XML representation of the skeleton of a schema.
In order to generate such namespaces:

e UML model must have Package with name “http://www.w3.0rg/2001/XMLSchema”
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e UML model must have Package with name “http://www.example.com/example”

e Permission with name “xs” must be added into model between XMLSchema Class and
Package “http.//www.w3.0rg/2001/XMLSchema”.

e Permission without name must be added into model between XMLSchema Class and Package
“http.//www.w3.0rg/2001/XMLSchema”.

XML schema namespaces UML Model example

For an example, see “schema UML Model example” on page 123.



	Contents
	Getting started
	Introduction
	Installing Cameo Data Modeler Plugin

	Entity-Relationship (ER) Modeling and Diagrams
	Introduction
	Basic Concepts
	Business Entity-Relationship Diagrams
	Identifying Relationships and Dependent Entities
	Constraints between Relationships
	Generalization and Specialization
	Key Modeling
	Virtual Entities
	Importing CA ERwin® Data Modeler Projects
	Importing Data Models
	Imported Elements


	Database support
	Introduction
	SQL Diagrams
	Crow’s Foot Notation in SQL Diagrams

	Database Modeling
	Common SQL Element Properties
	Top Level Elements
	Tables, Columns, and Views
	Modeling Types
	Sequences and Autoincrement Columns
	Constraints
	Routines
	Access Control
	Oracle Database Modeling Extensions

	Database Code Engineering
	Code Engineering Set
	Supported SQL Statements
	DDL Dialects


	Transformations
	Introduction
	UML to SQL Transformation
	Transformation Procedure
	Type Mapping
	Transformation Properties

	ER to SQL (Generic / Oracle) Transformations
	Identifying Relationships
	Key Transformation
	Virtual Entity Transformation
	Tracing between Data Model Layers

	SQL to UML Transformation
	Type Mapping
	Transformation Results

	UML to XML Schema Transformation
	Type Mapping
	Transformation Results

	XML Schema to UML Transformation
	Type Mapping
	Transformation Results


	Entity-Relationship and SQL Report
	XML schemas
	Introduction
	XML Schema Mapping to UML Elements
	Defined stereotypes
	attribute
	element
	complexType
	attributeGroup
	simpleType
	restriction
	list
	union
	minExclusive
	maxExclusive
	minInclusive
	maxInclusive
	totalDigits
	fractionDigits
	lenght
	minLength
	maxLength
	whiteSpace
	pattern
	enumeration
	unique
	key
	keyref
	selector and field
	annotation
	compositors
	group
	any and anyAttribute
	schema
	notation
	redefine
	import
	include
	XML schema namespaces



